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O p e n i n g  A c t i v i t y  
Concepts 
• Introduction to TI Navigator™ 
• Basic functionality of the NavNet App 

on the calculator 

Materials 
• TI-84 Plus 
• TI-Navigator system 

Overview 
Participants will experience TI-Navigator™ from a student’s perspective.  

 Using the Calculator 

1. Press the É button located on the bottom left of the 
calculator. 

2. Press the Œ button. 

3. Move down to NavNet (or ƒ N). See Figure 1. 

4. Press Í to open NavNet. See Figure 2. 

5. Sign in using the user name and password given you by 
the instructor. You will now be at the TI-Navigator Home 
screen. See Figure 3. 
• The name may be as few as 3 characters but cannot 

exceed 32 characters. 
• By default, the calculator is in ALPHA mode. The 

letters are in green above the keys. 

Introduction to Quick Poll 

1. Your instructor will ask you a series of questions. Answer 
each question by moving your cursor to your choice and 
pressing the o button. (“SEND” soft key) 

2. Sample questions: 
• Have you ever seen the TI-Navigator before? 

(Yes/No) 
• I’m excited about seeing what TI-Navigator has to 

offer for my classroom. (Agree/Disagree) {verbal} 
• The use of technology is welcomed in my classroom. 

(True/False) 
• I use technology in the classroom 

(Always/Sometimes/Never) 
• On a scale of 1-5, with 1 being the lowest, indicate 

your comfort level with using the computer. Use A 
for 1, up to E for 5. (Multiple Choice A through E) 
{verbal} 

Figure 1 

Figure 2 

Figure 3 



Opening Activity 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING TI-NAVIGATOR™       © 2005 TEXAS INSTRUMENTS INCORPORATED 

 

 
• How many years have you been teaching? (Open 

Response) 

Introduction to Screen Capture 

1. Exit NavNet by pressing the “QUIT” soft key (s 
button). 

2. Clear the Home screen by pressing the ‘ button. 

3. Your instructor will ask you a series of questions. Answer 
each question by typing your answer on the Home screen. 
Clear the Home screen after each answer. 

4. Sample questions: 
• Simplify the expression: (x-5)2. 
• Graph your favorite equation. 
• Display the window settings for your graph. 
• Press the following key sequence on your calculator. 
y Ã Á. 

Introduction to Activity Center 

1. Go back to NavNet (Œ, select NavNet). Notice that 
you don’t have to log in again. During any class session, 
you only have to log in once. 

2. Select 1:Activity Center from the TI-Navigator Home 
screen. See Figure 3. 

3. Play “Catch Me If You Can”. 
• The instructor will have a green cursor while each 

student will have a white cursor. 
• Chase the instructor’s cursor until you “catch” it. 
• After a while, the instructor will change each cursor 

to a unique shape and color. Can you identify 
yourself? 

4. Play “Guess My Rule”. 
• The instructor will ask you to contribute 3 points that 

follow a mathematical rule. 
• To contribute each point, press the “MARK” soft 

key. 
• After the instructor re-configures the activity, you 

will be asked to contribute an equation to fit the 
points on the screen. 

• To submit your equation, type it after the “y=” 
prompt and press the “SEND” soft key. 

Launch Pad Question 
Quick Poll: I’m ready to begin setting up my own Navigator 
Classroom. (Agree/Disagree) 
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S e t t i n g  U p  T h e  N a v i g a t o r  C l a s s r o o m  
Concepts 
• Setting up a TI-Navigator™ 

classroom 

Materials 
• TI-Navigator software. Overview 

Participants will add a class and populate that class with a sample student 
roster. They will also use other tools for managing a class.  

 

Adding Classes 

1. Begin the TI-Navigator software on the computer by 
double-clicking the TI-Navigator icon on the desktop. 
See Figure 1. 

2. Select the Add Class icon from the tool bar (see Figure 2) 
or select Add Class from the File menu. 

3. For each class enter the name of the class and press the 
Add Class button. When you have entered your last class, 
press the Finish button. We will create one class for this 
institute which we will call “Practice Class”. 

Adding Students 

1. Choose the student’s class from the pull down menu 
under Current Class. See Figure 3. 

2. Select the Add Student icon from the Classroom Tab or 
select Add Student from the Class menu. See Figure 4. 

3. For each student enter the student’s first name, last name, 
and user name. The user name must be globally unique 
for the entire TI-Navigator software. 

4. For this institute, we will use the following students: 
• Jon, Smith, Jon 
• Deb, Jones, Deb 
• Marco, Polo, Marco 
• Sonja, Perez, Sonja 
• Raymone, Tyson, Raymone 

Figure 1 

Figure 2 

Figure 3 

Figure 4 
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5. You may choose a password for each student, or each 
student may choose their own when they log in to 
NavNet for the first time. This will then be the student’s 
password unless the teacher chooses to reset it. 

6. The display name is seen only by the teacher in the 
Seating Chart view of the classroom. By default it is the 
student’s first name. You may choose to give any student 
a different display name. 

7. The Student ID is optional. 

8. The Assign Classes button allows the teacher to add the 
student to other Navigator classrooms. 

Viewing Classes in Seating Chart View Versus 
Student List View 

1. There are two ways to view the students in a classroom: 
Seating Chart and Student List. 

2. You may toggle between these two views by selecting the 
appropriate view under the View button. See Figure 5. 

3. Under the Seating Chart view you can rearrange the 
students to reflect their seating arrangement in the 
classroom. 

4. Under the Student List view, you can organize the 
students alphabetically by any attribute by clicking the 
title cell of a column.  

Teacher Preferences 

1. Teacher preferences are used to set the user name and 
password for the teacher to log in using a calculator. 

2. Logging in as the teacher allows access to key features of 
TI-Navigator from the calculator, such as Quick Poll, File 
Transfer, and Activity Center. 

3. To set up teacher preferences, select the Teacher 
Preferences icon from the tool bar or Teacher Preferences 
under the Tools menu. See Figure 6. 

4. Specify a username and password. For this institute use 
Teacher for the Username and AAA for the Password. 
See Figure 7. 

5. Click OK. 

Figure 5 

Figure 6 

Figure 7 
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Resetting Passwords 

1. For any reason a teacher may choose to reset passwords 
for any number of students. You may not change the 
password of any student who is currently logged on to the 
network. 

2. Select any students whose passwords you want to reset. 
You may hold down the “Ctrl” button on the keyboard to 
select any number of nonconsecutive students or the 
“Shift” button to select any number of consecutive 
students. 

3. Select Reset Password(s) from the Class menu.  
See Figure 8. 

4. The students will choose their new password the next 
time they log on to the network. 

5. If you want to specify passwords for the students, you 
must do so when you first add a student, or you may 
specify passwords one at a time after the class has been 
set up. Double-click a student or select a student and 
choose Properties from the Edit menu to set the 
password. 

6. Click the Reset button. 

7. Either allow the student to choose their password the next 
time they log in or specify a password. See Figure 9. 

Removing a Class or Student 

1. Removing a class: 
• From the pull down menu under Current Class select 

the class you want to remove. 
• Choose Remove Class from the File menu. 
• Confirm that the correct class is going to be removed 

and click the Remove button. See Figure 10. 
2. Removing a student: 

• From either the Seating Chart view or the Student 
List view, select the student you want to remove. 

• Click on the Remove Student icon or select Remove 
Student from the class menu. See Figure 11. 

• The student is removed from the class. The icon will 
be removed when you change classes and come back 
to this class or when you restart TI-Navigator. 

Figure 8 

Figure 9 

Figure 10 

Figure 11 



Setting Up The Navigator Classroom 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING TI-NAVIGATOR™       © 2005 TEXAS INSTRUMENTS INCORPORATED 

 

 

Dual-Enrollment or Moving a Student to a 
Different Class 

1. Double-click the student you wish to move or dual-enroll 
(or you may select the student and choose Properties 
from the Edit menu.) 

2. Select the Assign Classes button. See Figure 12. 

3. Use the check boxes to mark the class or classes you 
want the student to be assigned to. Uncheck any class you 
do not want the student to be enrolled in. 

Importing a Class Roster To a New Class 
(optional) 

1. An alternative to adding a class and adding students 
individually within the TI-Navigator software is creating 
a text file containing at least the following necessary 
fields: First Name, Last Name, and User Name. 
Notes:  
-students must be imported when the class is first created.
-you cannot import students to an existing class. 

2. Open Notepad or any other text editor. The file must be 
set up as follows: 
• At minimum line 1 of the file must have all of the 

following text typed exactly: First Name, Last Name, 
User Name (spaces after commas are optional.) 

• All other student property fields are optional, but if 
used, they must be typed on Line 1 separated by 
commas. 

• On each successive line, type the student properties 
chosen in the steps above separated by commas (e.g. 
Jack, Smith, Jack). Each student must be in a new 
line. See Figure 13. 

• Save the file as a text file (txt file extension). 
3. Begin the TI-Navigator software on the computer by 

double-clicking the TI-Navigator icon on the desktop. 
See Figure 1. 

4. Select the Add Class icon from the tool bar or select Add 
Class from the File menu. See Figure 2 

5. For each class enter the name of the class and click on the 
Add Class icon. See Figure 14. 

6. Select the class you just entered. 

7. Click on the Import Students button in the dialog box. 
Browse until you find the file that you saved in step 2. 

Figure 12 

Figure 13 

Figure 14 
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8. Click on the name of the file, and select Open. 
• When the import is successful, you will receive a 

confirmation message indicating the number of 
students added to the class. 

9. After you have added your last class, press the Finish 
button. 

10. Note: This process can be done using a spreadsheet 
program by using the cells to separate the data fields 
rather than commas. The file must be saved as a comma 
delimited file (csv file extension). 

11. You may also import all of your students to one master 
class list and then reassign them to their appropriate class 
after they have been created. 
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U s i n g  S c r e e n  C a p t u r e  
Concepts 
• Using Screen Capture to assess 

student understanding 

Materials 
• TI-84 Plus 
• TI-Navigator system 

Overview 
Participants will use Screen Capture to view the screen of any or all students. 

 
Creating Screen Captures 

1. Double click on the TI-Navigator icon from the desktop. 

2. Choose Practice Class from the pull-down menu under 
Current Class and click the Begin Class button. 

3. Log in two calculators as two students from the Practice 
Class. (e.g. Jon and Deb) 

4. Select the Screen Capture icon from the tool bar or the 
Tasks section of the Tools tab (or select Screen Capture 
from the Tools menu). See Figure 1. 

5. Select the Class icon to take a screen capture of the entire 
class or select the Students icon to take a screen capture 
of individual students. See Figure 2. 
• When using the Students option, hold down the 

“Ctrl” key to select any number of nonconsecutive 
students or hold down the “Shift” key to select any 
number of consecutive students. 

6. Click OK. 

7. The student calculator screens will be tiled alphabetically 
according to Last Name. See Figure 3. 

8. The teacher has the option of choosing whether the 
students names are displayed with the screen captures. 
• If a screen capture is viewed by the class, student 

names should not be displayed. 
• While the student calculators are on the Navigator 

Home screen, the screen capture will display student 
names. 

Figure 1 

Figure 2 

Figure 3 
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 • If a screen capture is performed when the student 
calculators are outside of the NavNet application, the 
student names will not display on the computer 
unless the Show Student Names is selected. 

9. On the student calculators, exit the NavNet application by 
selecting 4:Exit App from the TI-Navigator Home screen 
or the “QUIT” soft key. 

10. Type a message on each student calculator. 

11. On the computer, select the Refresh Screens icon on the 
Screen Capture window. See Figure 4. 

12. Toggle the Show Student Names option on and off to 
view the difference in the Screen Capture window. 

13. Experiment with the screen capture. 

14. To end the class session, on the computer, click the End 
Class button. 

Discussion on Usages in the Classroom 

1. What are the different usages of screen capture in a 
classroom? 

2. What are the educational advantages of using screen 
capture during a class? 

3. Think of a concept that was recently taught in your 
classroom, and write 5 different screen capture prompts. 

Figure 4 
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U s i n g  Q u i c k  P o l l  
Concepts 
• Using Quick Poll to assess student 

understanding 

Materials 
• TI-84 Plus 
• TI-Navigator system 

Overview 
Participants will use Quick Poll from both the computer and calculator to take 
a student poll. 

 

Quick Poll from the Computer 

1. Double click on the TI-Navigator icon from the desktop. 

2. Choose Practice Class from the pull down menu under 
Current Class and click the Begin Class button. 

3. Use the USB graph link cables to connect two calculators 
to the computer. Log in one calculator as a student in the 
Practice Class (e.g. Jon). 
• Press Œ button. 
• Use the down arrow, †, to move the cursor to 

NavNet. 
• Press Í button. 
• Enter a Username and Password. 

4. Conducting the poll: 
• Select the Quick Poll icon from the tool bar or the 

Tasks section of the Tools tab (or select Quick Poll 
from the Tools menu). See Figure 1. 

• Check the Resubmit check box to allow students to 
change their answer. 

• Choose Agree Disagree 3 from the pull down format. 
• In the entry box next to Poll Prompt type “I’m 

learning a lot about TI-Navigator.” See Figure 2. 
• Click on the Start Poll button to send the poll to the 

class. See Figure 3. 
5. Answering the quick poll as a student: 

• The question appears on the calculator. 
• The student scrolls to their answer choice using the 

arrow keys } † and pressing the “SEND” soft key 
to record their choice. 

Figure 1 

Figure 2 

Figure 3 
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• Since the teacher selected the Resubmit option, the 
student has the option of resubmitting their choice. 
Try it. 

6. Viewing poll results: (See Figure 4) 
• Click on the Stop Poll button to end the poll. (See 

Figure 5) You may pause and resume the poll if you 
choose. 

• Poll results are constantly updated on the computer. 
• Click on the Send Results button (Figure 6) to allow 

the students to view the poll results on their 
calculators. 

• The default view on the computer is Poll Details. 
You may also view individual student submissions 
under Poll Summary. 

• Student names are hidden by default and may be 
shown by marking the check box next to Show 
Student Names. See Figure 7. 

7. Try a few quick poll questions on your own. 

Discussion on Usages in the Classroom 

1. What are the different usages of quick poll in a 
classroom? 

2. What are the educational advantages of using quick poll 
during a class? 

3. Think of a concept that was recently taught in your 
classroom, and write five quick poll questions which 
could have been used to assess student understanding. 
Try to use various questions formats. 

4. What are the advantages of allowing students to resubmit 
their quick poll answers? 

Quick Poll From The Teacher Calculator 

1. Log into another calculator as the teacher.  
(e.g. Teacher, AAA) 

2. From the TI-Navigator Home screen on this calculator, 
choose 4:Quick Poll by pressing 4 and Í. 

3. Select the appropriate format. 

4. Ask the class a question verbally. 

5. Press the “SEND” soft key. 

6. On the student calculator, answer the question. Make sure 
you press the “SEND” soft key to record the answer. 

Figure 4 

Figure 5 

Figure 6 

Figure 7 
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7. Notice that the student results are recorded on the teacher 
calculator and the computer screen. 

8. To ask another question, use the “EDIT” soft key on the 
teacher calculator and go back to step 3. 

9. You may view the results on the computer screen or use 
the computer to send the results to the student calculators. 
Try it. 

10. Note: The resubmit option is not available when the 
quick poll is generated from the teacher calculator. 

Quick Poll History 

1. You may review the results of all quick poll questions 
from a current class session by clicking the History icon. 
See Figure 8. 

2. If you use the computer to conduct the quick poll and 
type the question in the Poll Question box, the question 
will also be saved in the History. 

3. Take a look at the quick poll history of your current 
Practice Class session. See Figure 9. 

 

Figure 8 

Figure 9 
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I n t r o d u c t i o n  t o  L e a r n i n g C h e c k ™  
Concepts 
• Basic functionality of 

LearningCheck™ Creator 

Materials 
• TI-84 Plus 
• TI-Navigator system 
• NavOpening.edc file 

Overview 
In this activity, participants will review the LearningCheck™ App from a 
student’s perspective. 

 

Using the Calculator (Participant Instruction) 

1. Press the É button located on the bottom left of the TI-
84 Plus. Press the Œ button. 

2. Use the down arrow † to move the cursor to NavNet. 
See Figure 1. 

3. Press Í to open the NavNet application. 

4. Enter your USERNAME as directed by your instructor 
and press Í. 

5. Enter your PASSWORD and press Í. 

6. At this point, the instructor will “force-send” you a file. 
Once the assignment has been received on your 
calculator, press q (“BACK” soft key). 
See Figure 2 

7. Move the cursor to NETWORK APPS and press Í. 
See Figure 3. 

8. Scroll to LearnChk and hit Í to open the app. See 
Figure 4. 

9. Press Í on the App Introduction screen. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 
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10. Move the cursor in the Assignment LIST to highlight the 
assignment called NavOpening. 
See Figure 5. 

11. Press Í on the calculator to open the NavOpening 
Assignment. 

12. Press Í on the first item in the list to view the first 
question. See Figure 6. 

13. Now you are ready to begin your journey exploring the 
Navigator functionality of LearningCheck. 

14. Begin the LearningCheck assignment called NavOpening 
and refer to the helpful hints below. 

Helpful Hints 

1. To move to the next question in a document, press the 
s key, which is below the softkey “NEXT”. 

2. To move to a previous question, press y s which 
will move the question sequence in reverse. 

3. To read text which extends beyond the text box on the 
screen, press } or †. 

4. To move between answers to a multiple choice question, 
press the } or † keys. 

5. To select an answer to a multiple-choice question, press 
Í on your selection to fill in the bubble. If the 
bubble is not filled in, your answer was NOT recorded. 

6. To select other options, press the o key which is below 
the softkey “MENU” on the calculator screen. 

7. Note: You can be certain that you have an answer that 
has been recorded for a question if there is a box in front 
of the title of the question. On the given student screen, 
Question 8 Grammar does not have an answer recorded. 
See Figure 7. 

Retrieve Class Data (Instructor Demonstration) 

1. The instructor will perform the sequence of steps for this 
section. The process is given here for you to follow 
along. 
• To retrieve class data, the instructor moves to the 

Class Analysis program by clicking the Class 
Analysis icon on the toolbar. See Figure 8. 

• Click on the Choose an Assignment for Analysis 
icon. See Figure 9. 

Figure 5 

Figure 6 

Figure 7 

Figure 8 

Figure 9 
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 • Browse for the NavOpening LearningCheck 
document and double click on it. See Figure 10. 

2. Click on the Collect Answer Files From Classroom 
Devices icon to retrieve the data from student calculators. 
See Figure 11. 

3. The pop-up window Collect Answer Files from Class 
appears and the following options are selected: 
• Delete Answer File from Device after Collect. 
• Delete Assignment File from Device after Collect. 
• This allows the teacher to manage the memory of the 

student calculators. Click the white boxes if the check 
marks are not present. 

4. Click the Start Transfer button from the resulting Collect 
Answer Files From Class at the bottom center of the pop-
up window. 
• The data collected from the student calculators is 

displayed in a spreadsheet. See Figure 12. 
• Each student’s data is coming in as a separate file 

called a user file with a file extension .usf. 
• Class Analysis calls on these files and displays them 

as a spreadsheet. The data will not be lost unless you 
delete the user files. 

5. From this point, the data can be printed, saved, and 
viewed in a slide show. 

6. A valuable tool in TI-Navigator is the Class Results Slide 
Show option. Access this from the icon on the top task 
bar. See Figure 13. 

7. The beginning of the slide show will show the title of the 
activity. See Figure 14. 
• The menu bar at the top will allow you to move 

between questions and display a bar graph of answers 
among the class. 

• The first question frame in the NavOpening activity 
appears as shown in Figure 15. 

8. A bar graph of student responses is shown to the right. 
Note that if a teacher registers a response as the correct 
answer the bar will be green instead of blue.  
See Figure 16. 

Figure 10 

Figure 11 

Figure 12 

Figure 13 

Figure 14 

Figure 15 

Figure 16 
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L e a r n i n g C h e c k ™  
E n t e r i n g  I n f o r m a t i o n  

Concepts 
• Entering information in a 

LearningCheck™ file 

Materials 
• TI-Navigator system™ 
• HUB.jpg file 

Overview 
In this activity, you will enter one information item that includes both text and 
an image.  

 

Introduction 

1. Double click on the TI LearningCheck™ Creator icon 
from the desktop. See Figure 1. 

2. Click OK on User Profile Selection – guest pop-up 
window. 

Entering Information 

1. Single click on the Text and Image button under the 
Information heading. See Figure 2. 
• In the Item 1 Template (Text and Image), clear out 

the existing title and enter “Hubs” in the white text 
box beside the Title. 

2. In the Hubs Template (Text and Image) enter the 
following information in the white box in the Text 
section: 
• “Hubs allow communication between student 

calculators and the access point in the Navigator 
system.” 

3. Click on the Browse button in the Image section of the 
pop-up window. 

4. Use the pull down menu next to “Look in:” to find the 
file location that contains the jpeg image called HUB as 
directed by your instructor. 

5. Select the HUB.jpg image and double click on the file 
name. 

Figure 1 

Figure 2 
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6. Use the Device Type Pull-Down Menu to choose the 
view to the TI-83 Plus Family. See Figure 3. 

7. Click on the Scale/Crop Tool. See Figure 4. 
• Note: For some images (bitmap, jpeg) that are not 

created on the calculator, using the Scale/Crop Tool 
causes a portion of the original image to be shown. 
See Figure 5. Its use is not recommended for this 
application. 

• Click on the Scale/Crop Tool to get the image back to 
normal. 

8. Why does the tool exist? 
• The Scale/Crop Tool is useful when using a captured 

device screen (PIC file) as an image. When viewing a 
PIC, the scale/cropped image will be the exact size of 
the viewable area on the calculator screen. 

9. Click OK to register the information and return to the 
main screen. 

Previewing Questions on the Computer 

1. Click on the Tools in the top menu. Move the cursor to 
Preview and then select Preview All. See Figure 6. 

2. In the Select a Device pop-up window click OK to select 
the TI-83 Plus Family. 
• Note that the preview can be changed to the TI-84 

Plus family by clicking the down arrow. 
3. Watch the upper left corner of the computer screen to 

preview the screens viewed by the students. 
• Note all the calculator keystrokes (rectangles around 

certain words, ex. p) indicated for the 
remainder of the steps are not pushed on the 
calculator. Instead, use the mouse to move the 
computer’s mouse pointer over the appropriate button 
on the image of the calculator that will pop-up.  
See Figure 7. 

4. Click on the q key to view the image after you have 
read the information. 

5. Click on the s key to go to the next screen. Since all 
the information has been viewed you will see a summary 
of the information. 

6. Close the pop-up window. 

Figure 3 

Figure 4 

Figure 5 

Figure 6 

Figure 7 
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Saving the Education Document (edc file) 

1. Click on File in the top menu. 

2. Select Save. 

3. To change the file name from the default name type “Info 
Example”. 

4. Double click on the folder directed by the instructor, 
which will be your personal folder to save all other files 
during the institute. 

5. Click on the Save button. 

6. Close the TI-LearningCheck Creator software. 
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L e a r n i n g C h e c k ™  E n t e r i n g  
M u l t i p l e  C h o i c e  Q u e s t i o n s  

Concepts 
• Types of multiple choice questions 
• Creation of multiple choice questions 
• Graphics in multiple choice questions 

Materials 
• TI-84 Plus™ 
• TI-Navigator system™ 
• Reference sheet from instructor for 

multiple choice questions 

Overview 
In this activity, you will enter three multiple choice questions (Standard 
Choices, Custom Choices, Choices on Image) and send the created 
education document to the class using the TI-Navigator™ system.  

 

Introduction 

1. Double click on the TI LearningCheck Creator icon from 
the desktop. 

2. Click OK on User Profile Selection – guest pop-up 
window. 

Entering Standard Choices Multiple Choice 
Question 

1. Single click on Standard Choices button under Multiple 
Choice Questions heading. See Figure 1. 

2. In the Item 1 Template (Multiple Choice – Standard 
Choices) pop-up window, click the pull-down arrow 
under Response in the Response section. 
• Cursor to the appropriate answer choice option for 

the Multiple Choice – Standard Choices on the 
Reference Sheet and click the left mouse button. 

3. To identify a choice as correct click on the circle beside 
the desired response. The correct answer for this question 
is underlined on your Reference Sheet. 
• In situations where there is no correct answer, such as 

opinion polling, no circle should be selected. 
4. Click inside the white Text field under the Question 

section and enter: 
• The text from the Multiple Choice – Standard 

Choices on the Reference Sheet. 

Figure 1 
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• This will become the title of the question by default. 

But, if you want a different title in the title box, you 
can click on the white box beside Title in the pop-up 
window. 

5. Click OK at the bottom right corner of the window. 

Entering Custom Choices Multiple Choice 
Question 

1. Single click on the Custom Choices button under the 
Multiple Choice Questions heading. See Figure 1. 

2. In the Item 2 Template (Multiple Choice – Custom 
Choices), click inside the white Text field under the 
Question section and enter: 
• The text from the Multiple Choice – Custom Choices 

on the Reference Sheet. 
• If you need special symbols, use the character map. 

Click on Tool in the menu bar and select Character 
Map. See Figure 2. 

• The Character Map can be used to create various 
symbols in LearningCheck documents as needed. 

3. Click inside the white Text field under the Response 
section and enter: 
• The first answer choice listed from the Multiple 

Choice – Custom Choices on the Reference Sheet. 
4. Click on New at the bottom right of the text box and 

enter: 
• The second answer choice listed from the Multiple 

Choice – Custom Choices on the Reference Sheet. 
5. Click on New at the bottom right of the text box and 

enter: 
• The third answer choice listed from the Multiple 

Choice – Custom Choices on the Reference Sheet. 
6. Click on New at the bottom right of the text box and 

enter: 
• The fourth answer choice listed from the Multiple 

Choice – Custom Choices on the Reference Sheet. 
7. Click in the circle to the left of the correct answer choice 

which is underlined on the Reference Sheet, marking this 
as the correct response. 

8. Click OK at the bottom right hand corner of the window. 

Figure 2 
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Entering Choice On Image Multiple Choice 
Question 

1. Single click on the Choices on Image button under the 
Multiple Choice Questions heading. See Figure 1. 

2. In the Item 3 Template (Multiple Choice – Choices on 
Image), click inside the white Text field under the 
Question section and enter: 
• The text from the Multiple Choice – Choices on 

Image on the Reference Sheet. 
3. Click on Browse in the Response section of the pop-up 

window. 
• Use the pull-down menu next to “Look in:” to find 

the file location that contains the bitmap image as 
directed by your instructor. 

4. Select the appropriate image file listed on the Reference 
Sheet and double click on the file name. 

5. Select the TI-84 family in the Device Type pull-down 
menu. See Figure 3. 

6. Click on the Scale/Crop Tool, if necessary. See Figure 4. 

7. Click Correct Point Tool. See Figure 5. 

8. Move the cursor to the location of the filled-in bubble on 
the image on the Reference Sheet and left click. This 
marks the correct answer to the question. 

9. Click on the Incorrect Point Tool. See Figure 6. 

10. Place the cursor on the location of the open bubbles on 
the image on the Reference Sheet and left click each time 
to insert a point. This marks the incorrect answers to the 
question. 

11. If a point or points are outside the viewable region on the 
calculator, you will see the message, “One or more points 
is partially or completely outside the image”. 
• To move points within the image, use the Erase Tool 

to erase a single point or the Clear Tool to erase all 
points. See Figure 7. 

12. Click on the Label Points tool. See Figure 8. 

13. Click on each of the points you created in any order. 
Letters will be assigned to the points starting at A. 

14. To change a label, left click on it and type the desired 
label. 

Figure 3 

Figure 4 

Figure 5 

Figure 6 

Figure 7 

Figure 8 



LearningCheck™ Entering Multiple Choice Questions 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING TI-NAVIGATOR™       © 2005 TEXAS INSTRUMENTS INCORPORATED 

 

 • Labels must be uppercase letters or numbers and are 
one character in length. 

15. Click OK at the bottom right hand corner of the window. 

Creating Titles For Questions 

1. As you create a question, its title will be the first few 
words of the question, as the default set-up. See Figure 9. 
• Once a question is complete, you can rename it. 
• Change the title of at least one of the questions by: 

moving the mouse pointer over a blue question bar 
and double click  
or 
left click to highlight the question bar and right click 
and select Edit. 

2. In the white Text box next to Title, delete the current title 
and then type in the desired title. 

3. Click OK in the bottom right hand corner. 

Previewing Questions On The Computer 

1. Click on Tools in the top menu, move cursor to Preview 
and then select Preview All. See Figure 10. 

2. In the Select a Device pop-up window, change the device 
to the TI-84 Plus Family and click OK. 

3. Watch the upper left corner of your computer screen to 
preview the screens viewed by students. 
• Note all the handheld keystrokes (rectangles around 

certain words, for example, p) indicated for 
the remainder of the steps are not pushed on the 
calculator. 

• Instead you will use the mouse to move the 
computer’s mouse pointer over the appropriate button 
on the image of the calculator that will pop-up.  
See Figure 11. 

4. For the first question, click on the p button to 
move between the possible responses. 
• Since there are no arrows on the preview, you must 

use the p key (TAB soft key) to move between 
responses. 

5. When you have the desired response selected press 
ENTER on the computer keyboard. 

Figure 9 

Figure 10 

Figure 11 
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6. Use the s key to move to the next question. 

7. For the second question, click on the p button to 
move between possible responses. 

8. When you have the desired response selected press 
ENTER on the computer keyboard. 

9. Use the s key to move to the next question. 

10. For the third question, click on the q key to view the 
image after you have read the question. 

11. Use the p key to tab between the selections on the 
image. Press ENTER on the computer keyboard to select 
the desired point on the image. 

12. Use the s key to go to the next screen. Since all the 
questions have been viewed, you will see a summary of 
the questions answered. 

13. Close the pop-up window. 

Renaming The Education Document (.edc file) 

1. Double click on the default name of the document called 
Untitled 1, in order to rename your file. See Figure 12. 

2. Enter “MC Examples” in the white text box under 
Document Title. See Figure 13. 

3. Move the mouse pointer to the bottom right hand corner 
of the pop-up window and click OK. 

Saving The Education Document (.edc file) 

1. Click File in the top menu and select Save. See Figure 14. 

2. To change the file name from the default name, type 
“Multiple Choice Examples”. 

3. Click on the Save button. 

Simulating a Transfer with a Single Calculator 
From LearningCheck 

1. Make sure that the USB unit-to-unit cable is connecting 
the PC and the calculator together. 

2. Make sure the calculator is logged into NavNet. 

3. Click on the Send to Class icon. See Figure 15. 

Figure 12 

Figure 13 

Figure 14 

Figure 15 
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4. Change the Memory Location Selection to Archive. 

5. Click Send in the “Send to Class” window.  
See Figure 16. 

6. You will see the sent file listed in the Class Record List 
on the TI-Navigator Home Screen. This line will also 
show how many students have received the assignment. 
See Figure 17. 

7. The USB unit-to-unit cable simulates transfer of files to 
one calculator while the Access Point allows the transfer 
of files to many calculators in a wireless way. If the 
Access Point is not connected to your computer, the files 
to be transferred will automatically be sent down the 
USB cable even though the Class Icon has been selected. 
• If sending to class from the LearningCheck 

application, students must be logged into NavNet to 
receive the assignment. 

• If sending to class from the Navigator home screen, 
teachers have the option to “force send” to all 
connected students. 

8. At this point, the class has received the “Multiple Choice 
Examples” assignment on their calculator. 

Figure 16 

Figure 17 
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L e a r n i n g C h e c k  F i l l  I n  T h e  B l a n k  
Q u e s t i o n s  

Concepts 
• Creation of fill in the blank questions 
• Transferring an educational 

document to the class 

Materials 
• TI-84 Plus 
• TI-Navigator™ system 
• LearningCheck Creator program 

Overview 
In this activity, you will create fill in the blank questions with alpha and numeric 
input and retrieve the answer files from a class using the TI-Navigator system.  

 
Fill In The Blank Features 

1. LearningCheck questions can be composed by the teacher 
with blanks, allowing the students to enter their answers. 

2. The blanks may be constructed to hold alpha or numeric 
characters. 
• The student will automatically be able to enter alpha 

characters on the calculator if the teacher selects a 
text style fill in the blank. 

• If the teacher selects a numeric style fill in the blank 
question, the student will automatically be able to 
enter a numeric character on the calculator. 

3. For teachers who are concerned with students unable to 
spell adequately, a pull-down style fill in the blank 
question style can be selected. 
• It has the “feel” of a multiple choice question. 
• Students will be able to select a word from a pop-up 

window which will be inserted in the blank. 
• This works well for students with English as a second 

language. 

Composing Fill In The Blank Questions 

1. Click on the white page icon on the task bar to begin a 
new LearningCheck education document. 

2. Click OK on the User Profile Selection – Guest pop-up 
window. 

3. To start constructing the question, click the Fill in the 
Blank icon under Free Response Questions within the 
Main panel as shown in Figure 1. 
• The Item 1 Template (Fill in the Blank) will be seen 

as shown in Figure 2. 

Figure 1 

Figure 2 
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Using Fill In The Blank as a Drop-Down Option 

1. Highlight the default title “Item 1” in the white Title field 
(top left side of template) and enter the title from the Fill 
In The Blank – Pull-Down part of the Reference Sheet. 

2. Click on the white Text field (Question section) and enter 
the text from the Fill In The Blank – Pull-Down part of 
the Reference Sheet. 

3. To create a blank, highlight the word or number to be 
filled in by the student. 
• Move the mouse pointer to the word that was 

underlined in the text statement on the Reference 
Sheet and highlight it. See Figure 3. 

4. Press the Create Blank button below the Text box at the 
bottom right of the Question section. 
• Note the highlighted word is now a text type of Fill in 

the Blank recorded in the Response section. 
5. To create a pull-down type of Fill in the Blank question, 

move the cursor to the white circle to the left of the words 
Pull Down under the Response section title and left click 
with the mouse. 
• Note that under the List of Possible Responses the 

appearance of a multiple choice style of question 
appears. The correct response by default, is 
associated with the highlighted text. 

6. Move the mouse pointer over the New button in the 
Response section. Click the mouse button. 

7. From the Reference Sheet, enter the first choice for the 
blank in the Text field of the Response section. 

8. Move the mouse pointer over the New button in the 
Response section and click the button. 

9. From the Reference Sheet enter the second choice for the 
blank in the Text field of the Response section. 

10. Move the mouse pointer over the New button in the 
Response section and click the button. 

11. From the Reference Sheet enter the third choice for the 
blank in the Text field of the Response section.  
See Figure 4. 

12. Click OK at the bottom right hand corner of the Fill in the 
Blank template. This will close the template. 

Figure 3 

Figure 4 
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13. Double click on the default document name, Document 1, 

found on the left side of the Navigator software. 
• Overwrite the default name under Document Title by 

highlighting it and entering “Fill In The Blank”. 
• Click OK at the bottom right corner. 

Using Fill In The Blank - Text/Numeric Option 

1. Highlight the default title Item in the white Title field, 
(top left side of template) and enter the title given on your 
reference sheet. 

2. Click on the white Text field (Question Section) and 
enter the text from the Fill In The Blank – Text/Numeric 
part of the Reference Sheet. 

3. To create a blank, highlight the word or number to be 
filled in by the student. 
• Move the mouse pointer to the word that was 

underlined in the text statement on your reference 
sheet and highlight it. See Figure 5. 

4. Press the Create Blank button below the Text box at the 
bottom right of the Question section. 
• Note the highlighted word is now a text type of Fill in 

the Blank recorded in the Response section.  
See Figure 6. 

5. To create a second blank, highlight the word or number 
to be filled in by the student. 
• Move the mouse pointer to the number that was 

underlined in the text statement on your reference 
sheet and highlight it. 

6. Press the Create Blank button below the Text box at the 
bottom right of the Question section. 
• Note the highlighted word is now a text type of Fill in 

the Blank recorded in the Response section. 
• Under the type of response in the Response section, 

move your cursor to the circle on the left side of the 
word Number and left click with the mouse. 

• The program automatically copies your number and 
allows options for creating a range of values of the 
tolerance for a specific value. See Figure 7. 

7. Click OK at the bottom right hand corner of the Fill in the 
Blank template. This will close the template. 

8. Double click the default document name, Document 1, 
found on the left hand side of the TI-Navigator software. 

Figure 5 

Figure 6 

Figure 7 
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• Overwrite the default name under Document Title by 

highlighting it and entering “Fill in the Blank”. 
• Click OK at the bottom right corner. 

Simulating a Transfer with a Single Calculator 

1. Save the educational document by clicking the Save icon 
or use the File, Save menu. See Figure 8. 

2. Make sure that the USB unit-to-unit cable is connecting 
the PC and the calculator together. 

3. Make sure the calculator is logged into NavNet. 

4. Send the Fill in the Blank education document to the 
class using the Send to Class icon. 

Answering a Fill In the Blank Question 

1. Access and begin the assignment on the calculator. 

2. The first blank is surrounded by a rectangle as shown in 
Figure 9. 

3. If a blank was set up as a: 
• PULL DOWN, any key will access the words that 

can be inserted into the blank. See Figure 10. Press 
the number of the word desired or use the } or † 
arrow keys to highlight the number next to the word. 
Press Í to select the word. 

• TEXT RESPONSE, the calculator keypad is locked 
in alpha mode (A appears in the top right hand corner 
of the calculator screen). See Figure 11. Find the 
green letters on the calculator keypad (or use the TI-
keyboard) and enter the correct answer. 

• MULTIPLE BLANK QUESTION, press the p 
key to move to the next blank. This key is below the 
word TAB on the calculator screen. See Figure 12. 

• NUMERIC RESPONSE, press the numbers on the 
calculator keypad that corresponds to the desired 
answer. See Figure 13. 

4. Press the s key to move to the NEXT question. 

5. When the last question is answered, the App returns to 
the item list. The presence of a square to the left of a 
question’s name indicates that the question has been 
answered. See Figure 14. 

6. To exit the LearnChk App, press the o key found under 
the word MENU from the calculator screen. 

7. Select 5 to exit the App. 

Figure 8 

Figure 9 

Figure 10 

Figure 11 

Figure 12 

Figure 13 

Figure 14 
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Simulating a Collection from a Single 
Calculator from Class Analysis 

8. Return to the computer and select the sent file listed in 
the Class Record. If there are students who did not 
receive the file, you must stop the transfer before you can 
collect the answers by clicking the STOP button. 
See Figure 15. 

9. The program which collects and grades the answers to an 
educational document is Class Analysis. 

10. Click on the Class Analysis icon from within the TI-
Navigator software or from the desktop. See Figure 16. 

11. Once Class Analysis is open, click on the Choose an 
Assignment for Analysis icon. See Figure 17. 

12. Browse for the Fill in the Blank educational document 
(*.edc) that was saved earlier, select the file and click on 
Open. See Figure 18. 

13. Click on the Collect Answer Files From Classroom 
Devices icon to retrieve the data from student calculators. 
See Figure 19. 

14. The pop-up window Collect Answer Files from Class 
appears as shown in Figure 20. Ensure that there are 
checkmarks to the left of the options: 
• Delete Answer File from Device after Collect. 
• Delete Assignment File from Device after Collect. 
• This allows the teacher to manage the memory of the 

student calculators. Click the white boxes if the 
checkmarks are not present. 

15. Acting in the role of teacher, retrieve the student data 
from the calculator by pressing the Start Transfer button 
as shown in Figure 20. 
• Be sure that the calculator and the computer are 

connected with the USB unit-to-unit cable. 
16. Once the transfer is complete, two green file names 

appear on the pop-up transfer window. See Figure 21. 
• One file is the assignment file (…\FILLINT…) and 

one is the answer file (…\UFILLINT…) 
• Use the mouse to click on the Close button to stop the 

transfer. 
17. The data is collected from the calculators and displayed 

in a spreadsheet. 

Figure 15 

Figure 16 

Figure 17 

Figure 18 

Figure 19 

Figure 20 

Figure 21 
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• From this point, the data can be printed, saved and 
viewed in a slide show. 

• Each student’s data is coming with a file extension 
.usf 

• Class Analysis calls on these files and displays them 
as a spreadsheet. The data will not be lost unless you 
delete the user files. 

18. To save the data, click on File at the top left corner of the 
software window and select Save to save the file on the 
desktop of the computer. See Figure 22. 
• The assessment results are saved in a .caf file (Class 

Analysis file). The LearningCheck document is saved 
in an .edc file (education document). 

19. To print a report, click on File at the top left corner of the 
software window and select Print Report. See Figure 23. 

20. Explore the various printing options. 
• The Class Summary option will give the spreadsheet 

of grades for all students. 
• Selecting Hard Copy of Assignment will print a copy 

of the assignment without answers. This utility works 
well for file copies or makeup work. 

• If Answer Key and Include Item Data are both 
checked, a hard copy of the assignment with answers 
is printed for your files. 

21. A valuable tool in TI-Navigator is the Class Results Slide 
Show option. 

22. To examine the data from your questions in a slide show, 
click the Class Results Slide Show icon as shown in 
Figure 24 on the Class Analysis menu bar. 

23. The beginning of the slide show will show the title of the 
activity. 
• The menu bar at the top will allow you to move 

between questions and display a bar graph of answers 
among the class. See Figure 25. 

24. To access the bar graph of student responses, press the 
single right arrow from the menu. This moves you 
forward through the slide show. 

25. Note that if a teacher registers a response as the correct 
answer, the bar will be green instead of blue. 

26. Close the TI-Navigator software.  

Figure 22 

Figure 23 

Figure 24 

Figure 25 
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L e a r n i n g C h e c k  O p e n  R e s p o n s e  
Q u e s t i o n s  

Concepts 
• Answering Open Response 

questions with TI-keyboards 
• Writing Open Response questions 

Materials 
• TI-84 Plus 
• TI-Navigator™ system 
• TI-keyboard 

Overview 
In this activity, you will use the TI-keyboard to answer questions without 
having to use the ƒ button.  

 

Answering An Open Response Question 

1. Press the Œ button and use the arrow key to scroll 
down to NavNet. See Figure 1. 

2. Press Í to open the NavNet application.  
See Figure 2. 

3. Enter your USERNAME and press Í. Enter your 
PASSWORD and press the soft key OK. 

4. At this point, the instructor will “force send” you a file. 
Once the assignment has been received on your 
calculator, hit the BACK soft key. See Figure 3. 

5. Move the cursor to Network Apps and press Í.  
See Figure 4. 

6. Scroll to LearnChk and press Í to open the App. 
See Figure 5. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 

Figure 5 
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7. Press Í on the App introduction screen.  

See Figure 6. 

8. Move the cursor in the Assignment List to highlight the 
opening activity called “email addresses”. 

9. Press Í on the calculator to open the “email 
addresses” assignment. 

10. Press Í on name to get to the question. 

11. Press the MENU soft key and scroll down to 8:Use 
keyboard. See Figure 7. 

12. Use the TI-keyboard to type the text of the answer to the 
question, as you would use a word processor. When 
finished, press the NEXT soft key to move to the next 
question. 

13. Enter your e-mail address. To access the @ symbol on 
the calculator if keyboards are not available, press the o 
key which corresponds to MENU, scroll down to 
7:Special characters and select @. Press Í on the 
calculator, and the DONE soft key to paste the character 
on the screen. 

14. When finished entering the text, disconnect the calculator 
from the TI-keyboard. Reconnect the calculator to the 
hub. 

15. The instructor will collect answers from all participants 
when they are finished. 

Writing An Open Response Question 

1. To create an Open Response question, open the 
LearningCheck creator software. Click on Open 
Response as shown in Figure 8 to open the template for 
entering the question. 

2. Give the question a title. Use “Email Address” for this 
example. Then in the Text box below Question type the 
following: 
• If you wish to receive periodic updates on your 

child’s progress during the year, please enter your 
name and e-mail address below. See Figure 9. 

• Click OK to finish the question. 
3. There is an area for a suggested response, but Class 

Analysis does not grade Open Response Questions. 

4. Change the default document name, Document 1 to 
“Parent Email”. 

Figure 6 

Figure 7 

Figure 8 

Figure 9 
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Simulating A Transfer With A Single Calculator 

1. Save the educational document by clicking the Save icon 
or use the File, Save menu. 

2. Make sure that the USB unit to unit cable is connecting 
the PC and calculator together. 

3. Make sure the calculator is logged into NavNet. 

4. Send the Parent education document to the class using the 
Send to Class icon in LearningCheck. See Figure 10. 

5. As a student, open the question on your calculator and 
answer it. 

6. As the teacher, return to the computer and use Class 
Analysis to collect the student responses using the Collect 
Answer Files From Classroom Devices icon.  
See Figure 11. 

7. Examine the data from your question in a slide show by 
moving the cursor to the Slide Show icon on the Class 
Analysis menu bar. See Figure 12. 

Figure 10 

Figure 11 

Figure 12 
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L e a r n i n g C h e c k  S e q u e n c i n g  
Q u e s t i o n s  

Concepts 
• Answering ordered response or 

sequencing questions 
• Creating ordered response or 

sequencing questions 

Materials 
• TI-84 Plus 
• TI-Navigator™ system 

Overview 
In this activity, you will create and answer ordered response/sequencing 
questions and send the education document to a single calculator using the 
TI-Navigator system. 

 

Comments About Sequencing Questions 

1. A Sequencing question requires the student to sort items. 
For example, you can give students the steps of the 
scientific method in the incorrect order and have them 
rearrange them to the correct order. 

2. In this example, you will be given the days of the week in 
mixed order. Your task is to put them in the correct order. 

Answering A Sequencing Question 

1. The instructor will send you the “Days” education 
document. 

2. Once you receive the activity, access it through the 
menus. 

3. On the Days assignment, press Í to look at the 
question. See Figure 1. 

4. To move between the options press the } and † arrows. 

5. Notice when you enter the question, there is a new tab 
above the r soft key, which allows students to check 
the answer. See Figure 1. 

6. Press this kay and LearningCheck will tell you that the 
answer is incorrect. See Figure 2. 

7. To move items in the sequence, move to the desired 
location and press Í to select the item you want to 
move. Use the } and † arrow keys to move the item to 
the desired place and press Í to relocate the item. 
Note: If you need to do a calculation, you can pause the 
application in order to use the calculator. 

Figure 1 

Figure 2 
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Pausing The App To Answer A Question 

1. In order to pause the application, press the MENU soft 
key and select 5:Pause App. See Figure 3. 

2. You can now use the calculator for any necessary 
calculations. To re-enter Navnet, press the Œ key and 
select Navnet. You will automatically re-enter the App 
and the network. 

Writing An Ordered Response Question 

1. Open the LearningCheck Creator software. 

2. Click on Sequencing, (see Figure 4), to make the 
template appear in order to write the question. 

3. In the title box, type the title of the question. For this 
example use “Order”. 

4. To enter the text for the question, click on the text field 
under Question, and then type the text: 
”Put the numbers in order from least to greatest” 
See Figure 5. 

5. To enter the items to sort. Click the Text field under 
Response. 
Now you may enter the first item in the correct sequence. 
The first item will be “-6”. As you type the number will 
appear in the Correct item list. 

6. To enter the second item, “-3”, click NEW and type the 
number. See Figure 6. In the same manner, add the 
numbers “0”, “2” and “12”. 

7. To finish the question, click Generate Presentation 
Sequence. This will jumble the choices as they would 
appear on the calculator. See Figure 6. 

Figure 3 

Figure 4 

Figure 5 

Figure 6 
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8. Click OK to finish the question. 

9. To name the file that you will send to the calculator, 
double click in Document 1 along the left side of the 
screen. See Figure 7.  
This will open the Document Information window.  
See Figure 8.  
It will allow you to name the file as it will appear on the 
calculator. Enter the information such as author name, 
and identify the file as an Examination or Self-Check. In 
this window enter the name “Ordering”. Click OK to 
finish the changes. 

Sending To A Single Calculator 

1. Connect your calculator to your computer with the USB 
silver cable. 

2. Send the LearningCheck file “Ordering” to the calculator 
and practice answering the sequence question on the 
calculator.  

Figure 7 

Figure 8 
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Writing An Education Document 
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Wr i t i n g  A n  E d u c a t i o n  D o c u m e n t  
Concepts 
• Practice writing an education 

document with various types of 
questions 

• Practice sending and answering an 
education document 

• Practice collecting and viewing the 
answer file for an education 
document 

Materials 
• TI-84 Plus 
• TI-Navigator™ system 

Overview 
In this activity, you will practice writing questions for an education document, 
send the document to a class, answer the assignment on a student calculator, 
collect the student responses, and view the class results.  

 

Creating A 7-Question Education Document 

1. Open the TI-Navigator software. 

2. Open the LearningCheck Creator. 

3. Click OK in the User Profile Selection-Guest. 

4. Using the Assessment information from the Reference 
Sheet, create the following types of questions: 
• Multiple Choice 
• Fill-In-The-Blank (Drop Down) 
• Fill-In-The-Blank (2 Blanks) 
• Multiple Choice With Image 
• Sequencing 
• Open Response 

5. Save the file as “Assessment”. 

6. Login a student on a calculator. 

7. Using LearnCheck, send Assessment to the class (the 
single calculator in this case). 

8. Complete the assignment on the calculator. 

9. Retrieve the data using TI-Navigator. 

10. Examine the data from your assignment in a slide show. 

11. Save the Class Analysis file as “First Assignment”. 

12. Close the TI-Navigator software. 



Writing An Education Document 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING TI-NAVIGATOR™       © 2005 TEXAS INSTRUMENTS INCORPORATED 

 

This page is intentionally left blank. 



Item Banks 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING TI-NAVIGATOR™      © 2005 TEXAS INSTRUMENTS INCORPORATED 

I t e m  B a n k s  
Concepts 
• Use Item Bank questions in a 

LearnCheck file. 

Materials 
• TI-84 Plus 
• TI-Navigator™ system 

Overview 
Participants will experience TI-Navigator™ from a student’s perspective.  

 

Item Banks 

1. In the LearningCheck software, click File, Open Item 
Bank. See Figure 1. 

2. Choose the LearnCheck file called Middle School Math. 
See Figure 2. 

3. To transfer a question from the Item Bank into the 
working document, click and hold on the desired question 
and drag into the question section. See Figure 3. Figure 1 

Figure 2 

Figure 3 
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4. In order to close any Item Bank, right click on the Item 

Bank and choose Close Item Bank. See Figure 4. 

Notes 

1. To preview a question, double click on question in the 
Item Bank. 

2. You can insert several Item Banks by repeating steps 1 
and 2 above. 

3. Each Item Bank appears as a separate tab on the far right 
of the screen. See Figure 5. 

4. To switch between Item Banks, click on the desired tab. 

Figure 4 

Figure 5 
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S e n d i n g  F i l e s  
Concepts 
• Sending files 

Materials 
• TI-84 Plus 
• TI-Navigator system 
• Days.edc file 

Overview 
Participants will work on sending files using TI-Navigator. 

 
• Sending All Types of Calculator Files 

1. Open the TI-Navigator software. 

2. Begin Class and log in two student calculators. 

3. Click on the “Send to Class” icon. See Figure 1. 

4. Select file to send (e.g. Days.edc) and click Next.  
See Figure 2. 

5. Select Class or select Individual Student(s) using the 
“Ctrl” key to select non-consecutive students. 

6. If “Force send” is desired, click in white box to the left of 
“Force send to students now”. 

7. Click on Finish. See Figure 3. 

8. You will see the sent file listed in the Class Record List 
on the Navigator Home Screen. This line will also show 
how many of the students have received the file. 
See Figure 4. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 
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 Sending Education Document  
(Alternative Method) 

1. Open the TI-Navigator software. 

2. Begin Class and log in two student calculators. 

3. Open the Learning Check software by clicking the 
Learning Check icon. See Figure 5. 

4. Click OK on the User Profile Section window. 

5. Open the education document which is to be sent by 
clicking the Open File icon or by choosing Open under 
the File menu. 

6. Choose the file to be sent (e.g. Days.edc). 

7. Click on the Send to Class icon. See Figure 6. 

8. Select the appropriate properties and click the “Send” 
button. See Figure 7. 

9. You will be returned to the TI-Navigator software screen 
and the file will be listed under the Class Record listing. 
See Figure 8. 

10. Notes: 
• When sending an education document through 

LearningCheck, it will be sent to the entire class. 
• The USB cable simulates the transfer of files to one 

handheld while the Access Point allows the transfer 
of files to many handhelds in a wireless way. If the 
Access Point is not connected to your computer, the 
files to be transferred will automatically be sent down 
the USB cable even though the Class icon has been 
selected. 

• If sending to class from within the LearningCheck 
software (see Figure 9), students must be logged into 
NavNet to receive the assignment. This is a “Force 
Send” option. 

• If sending to class from the Navigator home screen 
(see Figure 10), teachers have the option to “Force 
Send” to all connected students or allow students to 
retrieve the transfer at their request. 

Figure 5 

Figure 6 

Figure 7 

Figure 8 

Figure 9 

Figure 10 
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C o l l e c t i n g  F i l e s  
Concepts 
• Collecting files from student 

calculators 

Materials 
• TI-84 Plus 
• TI-Navigator system 

Overview 
Participants will use TI-Navigator to collect files located on student calculators. 
The files can be collected from an individual student, a subset of students, or 
an entire class. 

 

Introduction 

1. In order to have a file to collect from the student 
calculators, enter numbers into list L1 of two calculators. 

2. Open the TI-Navigator software. 

3. Begin class and log in two student calculators. 

4. Click on the “collect from class” icon. See Figure 1. 

5. Select file to be collected (e.g. L1 under Lists) and click 
Next. See Figure 2. 
If you would like to collect more than one file from the 
student calculators, then highlight all desired files by 
using the “Ctrl” key. 

6. Select Class or select Individual Student(s) using the 
“Ctrl” key to select non-consecutive students. 

7. If “Force collect” is desired, click in the white box to the 
left of “Force collect from students now”. See Figure 3. 

8. If “Delete after collecting” is checked, after the collection 
both the assignment and answer file will be deleted from 
the calculators. 

9. Click on Next. 

10. Choose location where you would like the collected 
file(s) to be saved. See Figure 4. 

11. Click Finish. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 
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12. You will see the collected file listed in the Class Record 
List on the Navigator Home Screen. This line will also 
show how many of the students’ files have been received. 
See Figure 5. 

13. Discussion: How might this be a useful feature for your 
classroom? Figure 5 



Interdisciplinary Lesson: Research and Notes with StudyCards 

I n t e r d i s c i p l i n a r y  L e s s o n :   
R e s e a r c h  a n d  N o t e s  w i t h  

S t u d y C a r d s  
Concepts 
• Introduction to TI StudyCards Creator 

and App 
• Using Navigator to collect and share 

files 

Materials 
• TI-84 Plus 
• TI-Navigator system™ 
• TI StudyCards Creator 
• StudyCard App 

Overview 
Participants will simulate how students could use TI StudyCard Creator to 
produce notes for research or review and then work with TI-Navigator to 
collect and share the results with the class.  

 

Introduction To TI StudyCards Creator 

1. StudyCards Creator allows you to create stacks of 
electronic “flash” cards that can be downloaded to and 
displayed on your calculator. 

2. The software TI StudyCards Creator is available for free 
download from the web site http://education.ti.com for 
educators and students. 

3. There are two general types of stacks that are available 
and as you begin you need to decide what type of stack 
you want to create. 
• Self Check: This creates an index card that students 

can view on their calculator and “flip” the card to 
access more information or check their 
understanding.  
This may be particularly useful for research notes, 
where a key fact can be placed on one side and 
reference to author, publication, date, etc. can be 
placed on the “back”. 

• Multiple Choice: This allows the student to respond 
to a question on the front of a card by choosing an 
answer and then receive immediate feedback. If the 
student answer was incorrect, the correct answer is 
displayed, and the question is shuffled to the bottom 
of the deck to reappear until answered correctly. 
This may be particularly useful for review of notes 
and concepts or for studying for a unit or course 
assessment. 
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Sending StudyCards App To Calculators 

1. In order to view the StudyCard stacks made by the 
Creator software you need the StudyCards App to be on 
the calculator. This App comes preloaded on the TI-84 
and the TI-83 Plus Silver Edition, and unless it has been 
deleted, it does not need to be re-installed. 
• You may still want to follow through the steps below 

to practice distributing this to students who do not 
have the App on their calculators. It will not harm 
any files on the calculators by re-installing it. 

• You can install the App one calculator at a time by 
sending the App to the calculator via TI-Connect or 
the Creator software itself. 

• Or, alternatively you can use TI-Navigator to send it 
to all the calculators in the class at the same time. 

2. To use TI-Navigator, open the TI-Navigator software and 
once it is open, click on the Tools tab. Then click on the 
App Transfer icon. 
• Note: There is no need to login or begin the class to 

transfer Apps. This is similar to when you first load 
the Apps required to use TI-Navigator. 

3. Deselect all the Apps required for TI-Navigator since you 
have already transferred them by clicking on the Send 
box beside the App to remove the check mark.  
See Figure 1. 

4. Click on the Add Application button and browse to find 
the StudyCard App on your computer. Click Add to put 
the App on to the list to be transferred. The Send box 
should already be checked. See Figure 1. 
• Another App we will be using in the next activity is 

the Notefolio App. You may want to send it now too 
by also adding it to the list of Apps. 

5. Click Start Transfer to begin transferring the Apps 
selected. This will take a few minutes. 

6. After each calculator has the App successfully transferred 
you can stop the transfer and close the dialog box by 
clicking on the Stop Transfer button and then the Close 
button. On the calculator, press the Œ key and 
confirm that the App is now listed. (They are in 
alphabetical order so you may need to scroll down.) 

Figure 1 
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StudyCards For Sharing Research/Notes 

1. In this section we will explore using TI StudyCards 
Creator to collect research notes from groups in the class 
and share them with the rest of the class. Alternatively 
this could be used as a way to prepare review notes for a 
unit or course assessment.  
One scenario is where you may ask different groups in 
class to research a section of a topic or a unit or course. 
Using TI StudyCards Creator they will create a stack of 
cards on that topic and using TI-Navigator you will 
collect their work and distribute it to the rest of the class. 
Thus everyone in the class will share the benefit of all the 
work done by others. As a teacher you may also keep a 
copy of the electronic stacks on the computer and assess 
the student work.  

2. Begin the TI StudyCards Creator software by double 
clicking on the icon on the desktop. 

3. You will be asked to indicate whether it is a New Stack 
or you wish to open an existing stack of StudyCards. This 
is a New Stack. Select the TI-83 Plus Family/TI-84 Plus 
Family. Also select the stack type. We can start with Self 
Check but feel free to create another stack with Multiple 
Choice later. Click OK. See Figure 2. 
• Note: With Levels indicates that cards can be created 

with levels of difficulty requiring students to master 
easier questions before moving on to more difficult 
ones. 

4. To create a card it is a matter of simply filling in the 
various fields. Select a title for your stack, such as 
“Research” or if for a particular topic or unit you may 
wish to give it that name. Version number, Created By 
and Date are optional but valuable when students are 
creating stacks to share with the class. See Figure 3. 

5. Each card should be given a name as an identifier. This 
will make it easier when sorting a large stack of cards by 
various sub topics. 

6. Finally you can place information that will appear on the 
front and back of the card. Since this is a Self Check 
there is no field to indicate a correct answer. If you select 
Multiple Choice you will be asked for choices or answers 
and to indicate the correct choice. 

7. When you are finished with the first card you may either 
select New Card under the Edit menu or click the icon on 
the tool bar to move to a new card. 

Figure 2 

Figure 3 
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 8. Create a second and third card to practice with the 
software.  
• Note you may also include graphics on the cards. 
• Notice that under the list of cards you may change 

the order of the cards. This is particularly useful 
when students are conducting research notes and may 
need to re-order the subtopics or group certain facts 
together. 

9. Once you have finished creating the stack, save it as a file 
on the computer. (File Save) You also will want to send 
the stack to one of your calculators. To send the stack to 
your calculator select Send to Device under the Action 
menu or select the icon on the toolbar. Ensure the 
calculator is connected to the computer via the graph link 
cable. 
• Notice if the StudyCard App is not already on the 

calculator you can send it to the calculator using the 
Action menu and selecting Send StudyCards App.  

10. Once you send the stack to the calculator you are now 
ready to view it using the StudyCard App on the 
calculator. 

11. To simulate a classroom environment you may want to 
create another stack of StudyCards, (perhaps Multiple 
Choice) and place these on the other calculator. To start a 
new stack you may select New from the File menu, or 
click on the icon on the toolbar or exit and re-enter the 
software. Ensure you give this stack a different name than 
the previous one for when we collect and share stacks 
using TI-Navigator. 

Viewing A StudyCard Stack 

1. To view and use stacks of StudyCards created on the 
computer, press the Œ key and choose the application 
entitled StudyCrd. 

2. After the introduction screen a menu will appear allowing 
you to either continue with the last stack you used (1) or 
choose from all the stacks loaded on the calculator (2). 
You may also change the Settings to allow cards to repeat 
or be shuffled. See Figure 4. 

3. Open the stack you sent to the calculator by selecting 2 
and then the stack you created. 

Figure 4 
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4. If the cards are in Self Check format they will function as 
index cards. The first screen is the front of the card. By 
pressing the soft key FLIP which is the r key you 
can see the back of the card. The ~ key moves to the 
next card, | moves to the previous card. } or † are 
used to see more of the text if it could not all fit on the 
screen. See Figure 5. 

5. If the cards are Multiple Choice format, the question will 
appear with numbered choices. When the number of a 
choice is entered then you will be told if the choice is 
correct or not. The correct answer will be displayed and 
incorrect responses will mean the card is shifted to the 
bottom of the stack. See Figure 6. 

6. The MENU soft key will take you to the main menu for 
other options or to exit the App. 

Collecting and Distributing StudyCard Stacks 
Using TI-Navigator 

1. Once each group has created a stack of research or review 
notes you can now use TI-Navigator to collect the files 
and then distribute them to the rest of the class. 

2. Open TI-Navigator and start the class. Login on your two 
calculators to simulate a classroom. Each “student” 
should have one of the two study card stacks you have 
created. In the classroom, as the teacher you will need to 
know the name of the stack. You may wish to assign 
particular topic names for the stacks to each group ahead 
of time. 

3. Click on the Collect from Class icon. You will be taken 
through a three step process to collect the files. 

4. Step 1 is to select the files to collect. StudyCard stacks 
are stored as AppVars type of files. Select CUSTOM and 
then from the drop down menu choose APPVARS. 
Beside that type in the name of the file, noting that the 
name is case sensitive. When you are down click ADD. 
See Figure 7. 
You can at this stage select multiple files to collect. Add 
the other StudyCard stack name you created to the list. 
Although not everyone will have the files you listed you 
will be able to retrieve it from the calculator that contains 
that file. Click Next to continue. 

Figure 5 

Figure 6 

Figure 7 
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Figure 12 

Figure 11 

Figure 10 

Figure 9 

Figure 8 

2. How might being you be able to share other student work 
and files with TI-Navigator in this fashion? 

5. Step 2 is to indicate either you wish to collect from the 
whole class or from specific students. You may collect 
from the whole class in this case although only one 
student has each file.  
You may check the box Force collect from students now 
to ensure that you retrieve the file regardless of what the 
student is currently doing. Click Next. See Figure 8. 

6. Step 3 asks you to indicate what folder you wish to place 
the collected AppVar files. When you have selected the 
folder click Finish. See Figure 9. 

7. If you selected from the whole class when you click on a 
particular file in the Class Record you will see the one 
student who had the file in green, the other in yellow 
indicating that the file was not available on their 
calculator. The files will be collected in the folder you 
indicated with the student login in front of the file name. 
See Figure 10. 

8. To send the StudyCard stacks collected to the entire class 
for them to review click on the Send to Class icon. This 
will initiate a two step process. 

9. Step 1 is to select what files are to be sent. Find the folder 
where the StudyCard stacks were collected and highlight 
both files. Click Next. See Figure 11. 

10. Step 2 is to indicate who is to receive the files. In this 
case we want the entire class to receive the files. Students 
will thus receive their own file back plus all the other 
stacks created. You may also check Force send to 
students now to ensure students receive the files 
regardless of what they are doing at the time. Click 
Finish. See Figure 12. 

11. Students now will be able to review the research or notes 
created in StudyCards by their class mates by opening the 
StudyCard App and opening the various stacks. 

Discussion 

1. Discuss various ways you may be able to use StudyCards 
in your classes. 
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I n t e r d i s c i p l i n a r y  L e s s o n :   
Wo r k i n g  W i t h  T h e s e s  

Concepts 
• Introduction to TI NoteFolio Creator 

and App 
• Using Navigator to collect and share 

files 

Materials 
• TI-84 Plus 
• TI-Navigator system™ 
• TI NoteFolio Creator 
• NoteFolio App 
• TI Keyboard 

Overview 
Participants will simulate how students could use TI Notefolio App to write a 
thesis or introductory paragraph and then use TI-Navigator to collect the files 
and discuss them with the teacher and class.  

 

Introduction To TI NoteFolio Creator and App 

1. TI NoteFolio Creator is a software word processor which 
allows you to create notes and export them to your 
calculator. You can also create notes on the calculator 
with the NoteFolio App and import them into the TI 
NoteFolio Creator. The NoteFolio Creator has the basic 
features of a simple word processor with the added 
options of being able to import or export files with the 
graphing calculator. 

2. The software TI NoteFolio Creator is available for free 
download from the web site http://education.ti.com for 
educators and students. 

3. Another important feature when you install TI NoteFolio 
Creator is a NoteFolio plug-in is installed in MS Word 
which allows you to import and export the notes from the 
Creator into MS Word and vice versa. 
• An option on the menu bar in MS Word is added 

which says TI Tools. Under this menu you also have 
the option to send directly to the calculator a file 
created in MS Word. See Figure 1. 

• Also notes created on the calculator with the 
NoteFolio App or created in the NoteFolio Creator 
are MS Word compatible. Notes created on the 
calculator can be saved in the Creator or on the 
computer and then exported to MS Word. 

Figure 1 
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4. This feature of MS Word compatibility allows the 

opportunity for students to write notes or begin portions 
of a paper on the calculator and later export it to MS 
Word without having to retype the text. They then 
complete their work and format accordingly as before. 

Sending TI NoteFolio App To Calculators 

1. In order to create notes on the calculator you need the 
NoteFolio App to be on the calculator. This App comes 
preloaded on the TI-84, and unless it has been deleted, it 
does not need to be re-installed. 
• You may still want to follow through the steps below 

to practice distributing this to students who do not 
have the App on their calculators. It will not harm 
any files on the calculators by re-installing it. 

• You can install the App one calculator at a time by 
sending the App to the calculator via TI-Connect or 
the Creator software itself. 

• Or, alternatively you can use TI-Navigator to send it 
to all the calculators in the class at the same time. 

2. To use TI-Navigator, open the TI-Navigator software and 
once it is open, click on the Tools tab. Then click on the 
App Transfer icon. 
• Note: There is no need to login or begin the class to 

transfer Apps. This is similar to when you first load 
the Apps required to use TI-Navigator. 

3. Deselect all the Apps required for TI-Navigator since you 
have already transferred them by clicking on the Send 
box beside the App to remove the check mark.  
See Figure 2. 

4. Click on the Add Application button and browse to find 
the NoteFolio App on your computer. Click Add to put 
the App on to the list to be transferred. The Send box 
should already be checked. See Figure 2. 

5. Click Start Transfer to begin transferring the Apps 
selected. This will take a few minutes. 

6. After each calculator has the App successfully transferred 
you can stop the transfer and close the dialog box by 
clicking on the Stop Transfer button and then the Close 
button. On the calculator, press the Œ key and 
confirm that the App is now listed. (They are in 
alphabetical order so you may need to scroll down.) 

Figure 2 
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7. You may wish to open the NoteFolio Creator and type in 
some sample text and send it to the calculator either by 
using Send to Device under the Action menu or using the 
icon on the toolbar. Note you can also send the App to a 
single calculator using Send NoteFolio App under the 
same Action menu. See Figure 3. 

8. Similarly if you have MS Word you can create a Word 
document and also practice sending it to the calculator 
using the TI Tools menu options. 
• Note: The NoteFolio App is only a basic text editor 

and is limited to the memory available on the 
calculator so extremely large or graphic intensive 
files are not appropriate.  

9. You can open the NoteFolio file on your calculator by 
pressing the Œ key and selecting the NoteFlio App. 
After the introduction screen you will open to a blank 
document. See Figure 4. 

10. Pressing the MENU soft key (s) will give you a 
choice of options, one being File, over the o key. Under 
File you can choose to open an existing note and all 
Notefolio files on the calculator will be listed. Select the 
one you want to view. See Figure 5. 

11. Other options including Editing choices of Cut, Copy and 
Paste are also available using the soft keys. 

NoteFolio App For Analyzing Theses 

1. In this section we will explore using the NoteFolio App 
and the TI Keyboard as a method to discuss what makes a 
good thesis and an opportunity for the teacher to make 
edits and changes electronically to student work. 

2. Often one of the most difficult aspects of a paper for 
students in writing their thesis or introductory paragraph. 
One recommended method to have students improve their 
ability to write a good thesis or introductory paragraph is 
to see actual examples and discuss what is good or bad 
about a particular thesis and how it might be improved. 

3. Using the NoteFolio App we will create two different 
thesis or introductory paragraphs on the student 
calculators and use TI-Navigator to collect the files for 
teacher review and also to be able to display and discuss 
with the class. 

Figure 3 

Figure 4 

Figure 5 
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 4. Open the NoteFolio App to create a thesis or introductory 
paragraph. To type you can use the alpha keys on the 
calculator but if available connecting the full QWERTY 
TI Keyboard to the calculator will make the exercise very 
easy for students. Connect to the TI Keyboard using the 
same black unit to unit cable used to connect to the TI 
Navigator hubs. 

5. The Help menu will reveal various keyboard shortcuts 
which are available which you may wish to use. 

6. Once you have typed a thesis or introductory paragraph 
you need to use the File menu soft key on the calculator 
to Save the file. All students should save the file with the 
same name so it can be retrieved using TI-Navigator. In 
this example you may wish to call the NoteFolio files 
created on each calculator “THESIS”. See Figure 6. 

7. Using your other calculator type a different thesis or 
introductory paragraph and also save it as “THESIS”. 
This will simulate a class where each student is typing 
their own thesis. 

Collecting NoteFolio Files Using TI-Navigator 

1. Once each student has entered their thesis or introductory 
paragraph you can now use TI-Navigator to collect all the 
files and either review them yourself or display them for 
the class to discuss. 

2. Open TI-Navigator and start the class. Login on your two 
calculators to simulate a classroom. Each “student” will 
have the NoteFolio file called THESIS on the calculator. 

3. Click on the Collect from Class icon. You will be taken 
through a three step process to collect the files. 

4. Step 1 is to select the file to collect. NoteFolio files are 
stored as AppVars type of files. Select CUSTOM and 
then from the drop down menu choose APPVARS. 
Beside that type in the name of the file, in this case 
THESIS, noting that the name is case sensitive. When 
you are down click ADD. See Figure 7. 

5. Step 2 is to indicate that you wish to collect from the 
whole class. Note: You may also select from specific 
students if necessary.  
You may also check the box Force collect from students 
now to ensure that you retrieve the file regardless of what 
the student is currently doing. Click Next. See Figure 8. 

Figure 7 

Figure 6 

Figure 8 
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Figure 9 

Figure 10 

6. Step 3 asks you to indicate what folder you wish to place 
the collected AppVar files. When you have selected the 
folder click Finish. See Figure 9. 

7. The files will be collected in the folder you indicated with 
the student login in front of the file name. You will then 
know which file belongs to which student. See Figure 10. 

8. Double clicking on either of the files will open them in TI 
NoteFolio Creator. 

9. One option is that you may then review, edit, comment 
and re-save the file for each student if you wish to assess 
their work. Recall they can export the file into MS Word 
and continue working on their paper. 
The file could also be exported back to their calculator 
and they could work on it with the NoteFolio App if 
computer access is a limited. 

10. Another option is to open the file in TI NoteFolio Creator 
and display it for the class to discuss and suggest 
improvements. Again the file can be edited as per the 
discussion and re-saved and later exported to MS Word. 
This provides a good opportunity for students to examine 
a number of various theses or introductory paragraphs 
and discuss the components of a good thesis and where 
improvements may be made. A large number of students 
can quickly and easily receive teacher and peer feedback 
as all students visually can read the thesis. 
Note: One area which may be a concern is the displaying 
of a student’s name. TI-Navigator when collecting the 
THESIS file will place the user name in front of the file. 
Possible solutions around this if it is a concern are: 
• You can change the file name itself from 

Smith_John-THESIS to something such as 1-THESIS 
• You can copy text into a blank document 
• You can create a class of “fake” names and have 

students login to TI-Navigator with one of those 
names which only you and them would know 

11. Another option to collecting this type of work from 
students is to use a LearningCheck file and using an open 
response question where the students answer with their 
thesis or introductory paragraph. The responses can then 
be collected using Class Analysis. The disadvantage is 
that students lose the opportunity to edit their work and 
export it to a word processor such as MS Word to 
continue their work. 
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2. How might being you be able to share other student work 
and files with TI-Navigator in this fashion? 

Discussion 

1. Discuss various ways you may be able to use NoteFolio 
in your classes. 
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H o m e w o r k  Q u e s t i o n s  
F r o m  T h e  C l a s s  

Concepts 
• Work with TI-InterActive!™ 
• Collect data from students using 

TI-Navigator™ 

Materials 
• TI-84 Plus 
• TI-Navigator™ system 
• TI-InterActive!™ 

Overview 
This activity will set up a TI-InterActive! document that will allow teachers to 
determine quickly which homework problems students were having difficulty 
completing.  

 

Setting Up The Worksheet 

1. Open the TI-InterActive! software by double clicking on 
the icon on the desktop. See Figure 1. 

2. Click the List icon. See Figure 2. This will open the Data 
Editor work area (or go to the Insert menu and choose 
“List”). 

3. Save the Data Editor work area to the worksheet 
document by clicking the “Save to Document” icon.  
(or go to the File menu and choose “Save to Document”) 
See Figures 3 and 4. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 
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4. Click the arrow to the right of the Graph icon and choose 
the Scatter Plot icon. See Figures 5 and 6. 

5. In the Functions window, see Figure 7, click on the Style 
icon. See Figure 8. 

6. Change the Plot Type to Histogram. See Figure 9. 
Figure 5 

Figure 6 

Figure 7 

Figure 8 

Figure 9 
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7. Type “L1” in the Xlist box and, if desired, change the 
color by clicking the Color box. See Figure 10. 

8. Click OK. 

9. Turn on the Histogram by clicking on the box to the left 
of the Style icon, See Figure 11. 

10. In the Graph window, adjust the settings so that the graph 
is only showing Quadrant 1. 
• Xmin = 0 
• Xmax = # of problems in homework assignment 
• Ymin = 0 
• Ymax = # of students in class divided by 2 

11. Save the Graph work area to the document worksheet by 
clicking the “Save to Document” icon, or from the File 
menu selecting “Save to document”. 

12. Now you are ready to collect the homework questions 
from your class. See Figure 12. 

13. Save the TI-InterActive! document for class by clicking 
the Save icon or go to the File menu and choose “Save”. 
Make a note as to where you have saved the file. 

14. Exit TI-InterActive!. 

Collecting Homework Questions From The 
Class 

1. Start the TI-Navigator software and have students log 
into the Navigator classroom. 

2. Start the TI-InterActive! software. 

3. Open the TI-InterActive! worksheet you created to 
collect the homework questions from the class by 
clicking the Open icon, browsing for the file and click 
Open. 

4. Have the students enter the homework questions in L1 for 
which they had difficulty. 
• Click the … key. 
• Choose 1:Edit. 
• Type each number of a homework question followed 

by the Í key. 
5. Double click on the Lists in the worksheet to open the 

Data Editor window. 

6. Go to the File menu, choose Import, then from Class.  
See Figure 13. 

Figure 10 

Figure 11 

Figure 12 

Figure 13 
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  7. Click on the Augmented List(s) tab. See Figure 14. 

8. Type L1 in the First row of boxes. 

9. Click Import. 

10. The students’ homework questions will be augmented 
into the Data Editor window’s L1. 

11. Click the “Save to Document” icon or go to the File 
menu and choose “Save to Document”. 

12. Now you will know what questions your students really 
need to see in class. 

13. For future reference, save the TI-InterActive! document 
worksheet. (see comments below) 

 Comments 
• Once the “Setting Up The Worksheet” steps are done 

once, the data list and graph can be copied and pasted 
for the next class. Or you can have a blank one set up 
for use each day and do a “Save As” at the end of 
class for your records (instead of just a “Save”). 

• Keeping a cumulative record of the question 
histograms can be useful the next time the course is 
taught. Modifications can be made to address the 
most common questions. See Figure 15.  

Figure 14 

Figure 15 
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A c t i v i t y  C e n t e r  
Concepts 
• Using Activity Center to conduct 

various activities 

Materials 
• TI-84 Plus™ 
• TI-Navigator system™ 

Overview 
Participants will use Activity Center to set up sample activities and experience 
them from both a student’s and teacher’s perspective. They will adjust the 
settings of different views and contribute points, equations and lists.  

 

Graph View Tab 

1. Begin the Practice Class and log in one of the calculators 
as the teacher and the other as a student. 

2. Select 1: Activity Center from the TI-Navigator Home. 
See Figure 1. 
• The calculator will display a message “WAITING 

FOR TEACHER”. See Figure 2. 
3. Select the Activity Center icon from the tool bar or the 

Tasks section of the Tools tab (or select Activity Center 
from the Tools menu). See Figure 3. 

4. There are five viewing tabs: List, List-Graph, Graph, 
Graph-Equation, Equation. 

5. Select the Graph tab.  

6. Change the basic window settings to [-20, 20] by [-5, 5] 
by entering the appropriate values in the boxes at the end 
of the axes. 
• Note the resulting changes to the viewing screen. 

7. Click on the Edit Window Settings icon or select Edit 
Window Settings from the Edit Menu. See Figure 4. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 
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8. Adjust the settings to reflect the following: (See Figure 5) 
• X scale of 2 
• Y scale of 2 
• Axis Labels turned on 
• X for X Label 
• Y for Y Label 

9. Click OK. 

10. From the Graph tab window the Axes, Axis Label and 
Grid options can be toggled on and off. Try it. 

11. To return to the Zoom Standard window settings quickly, 
click the Zoom Standard icon in the toolbar. See Figure 6. 

12. The Zoom In, Zoom Out and Zoom Square icons are used 
to quickly change the window settings. Try it. 
• The Zoom Stat icon is used to match window settings 

to lists. This will be discussed later. 
 

Contribute Points, Equations and Lists 

1. Setting up “Catch Me If You Can” activity: 
• From the Contribute pull-down menu within the 

Activity Center, select the Points option.  
See Figure 7. 

• Select the Configure button and use the following 
settings: (See Figure 8) 
Number of points per student: 0 
Step Size: 1 
X-List: X 
Y-List: Y 
Deselect (uncheck) Display Coordinates and Send 
Graph Contents as background 

• Select the OK button. 
2. Perform the “Catch Me If You Can” activity. 

• Select Start Activity from the toolbar, and “chase 
yourself” around the grid. 

• Select Stop Activity from the toolbar to end the 
activity. 

Figure 5 

Figure 6 

Figure 7 

Figure 8 
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3. Setting up “Guess My Rule” activity: 
• Click on the Zoom Standard icon followed by the 

Zoom Square icon. See Figure 9. This will give 
everyone convenient window settings. 

• Click on the Window Settings icon to change the X 
scale and Y scale to 1. 

• From the Contribute pull-down menu within the 
Activity Center, select the Points option.  
See Figure 7. 

• Select the Configure button and use the following 
settings: (See Figure 10) 
Number of points per student: 3 
Step Size: 0.5 
X-List: X 
Y-List: Y 
Select (check) Display Coordinates 
Select (check) Let Students Resubmit Points 
Deselect (uncheck) Send Graph Contents as 
background 
You can choose to allow students to submit points 
All At Once or One at a Time 

• Select the OK button 
4. Perform the “Guess My Rule” activity. 

• Select Start Activity from the toolbar. 
• On the student calculator mark 3 points according to 

the following rule:  
“Make your x-coordinate 1 greater than your y-
coordinate.” 

• Select Stop Activity from the toolbar. See Figure 11. 
• Reconfigure Activity Center to contribute Equations, 

with the following settings: (See Figure 12) 
Number of equations per student: 1 
Select Let students view graphs of equations 
Deselect Let students resubmit equations 
Deselect Send Current Graph Contents As 
Background 
Select Empty Equations 
(The other options are useful for other activities 
which you will see used later.) 

• Select the OK button 
• Select Start Activity from the toolbar. 
• On the student calculator enter a “guess” of the math 

rule that fits these points and [send]. 

Figure 9 

Figure 10 

Figure 11 

Figure 12 
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 • Select Stop Activity from the toolbar. 
See Figure 13. 

• To clear the data from the screen, from the Edit menu 
select Clear Activity Data. See Figure 14. 

• Practice another round using the following rule: 
“Make the y-coordinate two less than twice the x 
coordinate.” 

• Clear the data from the screen for the next activity 
(from the Edit menu select Clear Activity). 

5. Setting up “Happy Birthday – Part 1” activity: 
• From the Contribute pull-down menu within the 

Activity Center, select the Lists option. 
See Figure 15. 

• Select the Configure button and use the following 
List properties: (See Figure 16) 
Select Create independent lists using 1 list named L1. 

• Click the OK button. 
• Deselect Let students view sequence plots. 
• Select Empty lists. See Figure 17. (The other options 

are useful for other activities which we will use last.) 
• Click the OK button. 

Figure 13 

Figure 14 

Figure 15 

Figure 16 

Figure 17 
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6. Perform the “Happy Birthday – Part 1” activity: 
• Select Start Activity from the toolbar. 
• On the two calculators, enter five days and “Send” 

(to simulate 10 students’ days of birth). 
• Select the List tab to view the lists. See Figure 18. 
• Click the cell with L1 to order the list in 

ascending/descending order. 
• Question: “Can it be known from the list if any two 

students have the same birthday?” 
• Select Stop Activity from the toolbar. 
• Clear the data from the activity center (from the Edit 

menu select Clear Activity). 
• Select Start Activity from the toolbar. 
• On the two calculators, enter five months and “Send” 

(to simulate 10 students’ months of birth). 
• Click the cell with L1 to order the list in 

ascending/descending order. 
• Question: “Can it be known from the list if any two 

students have the same birthday?” 
• Select Stop Activity from the toolbar. 
• Clear the data from the activity center. 

7. Setting up “Happy Birthday – Part 2” activity: 
• Reconfigure the activity to contribute two lists (L1 

and L2) of the type “Group Lists as a Data Set”. 
See Figure 19. 

• Click the OK button. 
• Note: With creating a Data Set, lists are considered 

pairs whose dimensions must match, while creating 
Independent Lists may have different dimensions. 

• Use the following settings: (See Figure 20) 
Select Choose from Data Sets and use the pull-down 
menu to select the L1-L2 Data Set. 
Select Let students resubmit lists. 
Select Empty Lists. 

• Click the OK button. 
8. Performing the “Happy Birthday – Part 2” activity: 

• Select the Start Activity from the toolbar. 
• On the two calculators, enter five months (L1) and 

five days (L2) and “Send” (to simulate 10 students’ 
birthdays). 

• Select Stop Activity from the toolbar. 
• Question: “Can it be known from the grouped lists if 

any two students have the same birthday?” 

Figure 18 

Figure 19 

Figure 20 
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 9. Extension of the “Happy Birthday” activity: 
• Using the List-Graph tab, the scatter plot can be 

created of the collected data. 
• Question: “From the scatter plot, what indicates that 

students have the same day of birth? What about the 
same month of birth?” 

Reflections 

1. Having been introduced to the Activity Center, what are 
some things that you would like to be able to do with 
your class? 

2. In what ways could you use: 
• Contributing Points? 
• Contributing Equations? 
• Contributing Independent Lists? 
• Contributing Grouped Lists? 

3. How might you design lessons using more than one type 
of data contribution? 
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M a t h  L e s s o n :  S e n d i n g  I n t e r n e t  D a ta  
To  T h e  C l a s s  

Concepts 
• Downloading data from the Internet 
• Sending data to students 
• Saving and Collecting Pictures 

Materials 
• TI-84 Plus 
• TI-Navigator™ System 
• Internet access 
• TI Connect™ software 

Overview 
Participants will use data from the Internet to explore the changes in world 
population over time and to make projections into the future.  

 
Downloading The Data 

1. Open TI Connect software. 

2. To have a place to store the data, use TI Connect to create 
a list.  

• Click on TI DataEditor to begin. See Figure 1. 

3. Go to File, and then New.  

• Choose TI-83 Plus, List, and L1 from the pop-up 
window. See Figure 2. 

• This will create a column called L1.  

• Repeat this process to create a second list called L2.  

• Now minimize TI Connect. 

4. If you have access to the Internet, open the Internet 
browser and go to the world population data site for  
TI-InterActive!, 
education.ti.com/us/product/software/tii/datasites/worldp
op.html. See Figure 3. 

• If you do not have Internet access, then use the 
Internet explorer file called Data Sites –  
TI InterActive!  

• The file may be found at the direction of the 
instructor. 

5. Highlight the data for years and population by clicking 
the mouse on year 0. 

• Hold the mouse button down and drag to the end of 
the data. 

Figure 1 

Figure 2 

Figure 3 
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• Choose Edit and then Copy to copy the data to the 

clipboard. Using Ctrl – C on the computer keyboard 
will achieve the same goal. 

6. Minimize the Internet browser and maximize the  
TI DataEditor. 

7. Click the first position in L1.  

• Paste the data into L1 and L2 by choosing Edit and 
then Paste. Use Ctrl – V on the computer keyboard 
will achieve the same goal. See Figure 4. 

8. To save, click on L1, and then choose File and Save to 
save the list L1.  

• Repeat the process for L2.  

• Save the lists as directed by the instructor. 

Sending The Data To The Calculator 

1. Open the TI-Navigator software. Click Begin Class. 
Click the Send to Class icon on the menu bar. 

2. Step 1 of 2: Select the file(s) to send. Locate L1 and L2 
saved above and select both. Click Next. 

3. Step 2 of 2: Select student(s). Click Class to send to all 
students logged on or click Students and select particular 
students. If desired you can check the Force send to 
students now box. Click Finish. 

Creating The Scatter Plot On The Handheld 

1. Press ‘ to erase the Home Screen.  

• Press the … key. Choose 1:Edit. Press Í. 
This shows the data. See Figure 5. 

2. Press y [STAT PLOT] to access the Stat Plot menu. 
See Figure 6. 

3. Select Plot 1 by pressing Í. The word ON should be 
flashing. 

• Press Í to activate Plot 1. See Figure 7. 

4. Press † to go to Type. Beside Type select the first icon, 
which represents the scatter plot. 

5. Press † to go to Xlist. Press y [1] to get L1. 

6. Press † to go to Ylist. Press y [2] to get L2. 

7. Press † to go to Mark. Press ~ to go to smallest mark, 
Press Í. See Figure 8. 

Figure 4 

Figure 5 

Figure 6 

Figure 7 

Figure 8 
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8. Press q. Go to 9: ZoomStat to see the handheld-
generated graph of the world population data from year 0 
to 2150. See Figure 9. 

Saving Pictures  

1. Press y [DRAW] to access the DRAW menu.  

• Scroll to [STO] to store the picture in memory.  

• Save by choosing 1:StorePic and then press Í to 
confirm the save on the Home Screen of the 
handheld. See Figure 10.  

2. Enter “1” to give this picture a name. See Figure 11. 

• Press Í to store the picture in the handheld’s 
memory as PIC 1. 

Collecting Pictures 

1. Open TI Navigator software. Click Begin Class. Click the 
Collect from Class icon on the menu bar. 

2. Step 1 of 3: Select the file(s) to collect. Select PICS then 
Pic1. Click Next. See Figure 12. 

3. Step 2 of 3: Select student(s). Click Class in order to send 
to all students logged on or click Students and select 
particular students.  
If desired check the Force send to students now box.  
If desired check the Delete after collecting box. 
See Figure 13. 

Figure 10 

Figure 11 

Figure 9 

Figure 12 

Figure 13 
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 4. Step 3 of 3: Select collect folder. Save as directed by the 
instructor. Click Finish. See Figure 14. 

Notes For Teacher 

1. The teacher could also get a screen capture from all 
students, then display and discuss. 

2. To save the screen capture from students, the teacher 
could press Alt-PrntScrn to copy the Screen Capture 
window to the clipboard and then paste it into a Word (or 
similar) document. 

Figure 14 
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M a t h  L e s s o n :  P a s s  T h e  B a l l  
Math Concepts 
• Scatter plot 
• Function 
• Proportional relation 

Materials 
• TI-84 Plus 
• TI-Navigator™ 
• Stopwatch 
• Tennis ball 

Overview 
In this activity, we will collect data of the form (number of people, time it takes 
to pass a ball), make numerical prediction, build a scatter plot, and model with 
a proportional relation of the form y = mx. Data will be entered in Activity 
Center and transferred by TI-Navigator to student handhelds. 

 

Description Of The “Pass The Ball” Activity 

1. For the ball pass activity, begin by having three people 
stand in a circle.  
• You will be repeating the activity for six different 

numbers of teachers.   
• Use different teachers to maximize participation. 

2. For each round, the starter will bounce, catch, and pass 
the ball to the next person. Continue bouncing, catching, 
and passing the ball until it is back to the starter.   

3. Start and stop with the same person. Time how long it 
takes the ball to get all the way around the circle. Have 
teachers record the times on the table. See Figure 1. 

4. For the last round, have everyone in the room 
participate. Before timing, have teachers predict how 
long they think it will take and write it on their handout. 
Ask teachers to share their predictions. Then time. 

Using TI-Navigator For The Activity 

1. Launch TI-Navigator and Begin Class. 

2. Click the Send to Student icon. Select the two 
LearningCheck documents to send to the students, Post 
Test and Rule Answers. 

3. Describe the “Pass the Ball” activity to the participants 
and perform six rounds of the activity (just not the last 
round where everyone participates). 

4. Do a Quick Poll with the following three questions: 
• How long will it take to pass the ball to everyone? 
• How long will it take to pass the ball to 50 people? 
• How many people would be in the circle if it takes 

50 seconds to pass the ball? 

Sample Table 

Number of 
People 

Time in 
Seconds 

4 6 
6 9 
7 13 
9 16 
25 46 
N 1.7N  

Figure 1 
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5. Discuss the results. 

6. Click on the Activity Center icon. 
• Click on the List tab.  
• Click on the Create New List button. 
• Select Create Data Set and number of lists equal to 2. 
• Click OK. 
• Click in the data box for L1 and type in value. 
• Tab to L2 and type in value. Press enter and repeat 

until all data has been entered. 
• Select Contribute Lists and click Configure. 
• Select Existing activity lists then click OK. 

7. Click Start Activity to send the lists to the class. 

8. Once the class receives the lists, click Stop Activity. 
They can quit the App and make a scatter plot of the data 
in L1 and L2 and fit the data with a function rule.  
• Do not use the … button. 

9. Click on List-Graph tab. 
• Configure Plots for L1 and L2. 
• Use the settings icon to create an appropriate viewing 

window. 
• Select Contribute Equations, click Configure, with 

number of equations equal to 1. 
• Check Let students view graph of equations, do not 

check Send Graph Contents as Background. 
• Click on Graph-Equation tab to view graphs and 

equations as students contribute their equations. 
10. Have the participants complete the “Rule Answers” 

LearningCheck document. 
• This document contains several questions relating to 

the results. 
• Have participants use a consensus rule, or their own 

to respond to these questions. 
• Display answers using Slide Show and discuss 

results. 
11. Have the participants open the “Post Test” 

LearningCheck document and discuss. 
• This is a set of questions similar to the activity.  
• Use the Activity Worksheet for students to record 

solutions. 
• The results of this worksheet may be used as a 

summative assessment. 
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M a t h  L e s s o n :  P r o j e c t i l e  M o t i o n  
Concepts 
• Position, velocity, and acceleration 
• Collecting files from student 

handhelds 

Materials 
• TI-84 Plus 
• TI-Navigator™ software 
• TI-84 Plus picture PIC1 

Overview 
Participants will receive a graph of the height of a rocket over time. The 
instructor will ask participants questions about the rocket involving height, 
velocity, and acceleration. Participants will respond by moving the free-floating 
cursor to the appropriate point on their graph. After each question,  
TI-Navigator will be used collect participants' results (screen captures) and 
display them for the class. This display can encourage class discussion of the 
relation between height, velocity, acceleration, and the graph. 

 
• 

Introduction 

1. Students are often hesitant to respond to questions in 
class because they are afraid of being wrong.  
TI-Navigator allows students to respond to questions 
anonymously.  

2. This feature encourages more students to participate and 
become involved in classroom discussions.  

Procedure 

1. Launch TI-Navigator, Begin Class, then send the picture 
PIC1 to the class. 
• See the Tip Sheet for sending a picture. 

2. Participants should clear their o menus. 
• Go to the o menu and clear each entry. 

See Figure 1. 
• Deselect all scatter plots. 
• Set Window: Xmin = -1, Xmax = 15, Xscl = 1,  

Ymin = 0, Ymax = 500, Yscl = 100. See Figure 2. 
3. Participants should turn off their axes. 

• Go to the Graph Format by pressing y q 
([Format]).  

• Highlight AxesOff and press Í. See Figure 3. 
4. Each participant should open the picture PIC1. 

• Press y  ([Draw]). Scroll to STO, then use 
the arrow keys, and scroll to 2:RecallPic.  
See Figure 4. 

Figure 1 

Figure 3 

Figure 4 

Figure 2 
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• Press Í to paste the RecallPic command to the 
Home Screen. See Figure 5. 

• Select 1. See Figure 6. 
• Press Í to open the picture. See Figure 7. 

5. How high did the rocket travel? 
• Use your TI-84 Plus cursor movement keys and the 

free-floating cursor to mark the point on the graph 
that corresponds to the highest point in the rocket’s 
trajectory.  

• Wait for your instructor to collect the class results.  
• How high do you think the rocket traveled? 

6. The instructor will capture screen shots of each 
participant’s home screen and display the class results. 

7. The instructor should ask the participants to discuss the 
reasoning behind various answers (screen shots).  
• The responses should remain anonymous so that 

participants (students) are more likely to participate 
in the discussion. 

8. When was the rocket’s velocity zero? 
• When your teacher tells you to do so, mark the point 

on the graph that shows when the rocket’s velocity is 
zero.  

• Wait for your instructor to capture the screen shots 
and display class results, then choose one of the 
responses and explain why a student might have 
marked that point.  

• Tell whether or not you think this is the correct point. 
9. When did the rocket engine finish burning? 

• When your teacher tells you to do so, mark the point 
on the graph that shows when the rocket engine 
finished burning. Wait for your instructor to capture 
the screen shots and display class results. Use the 
collated results to see what your classmates thought. 

10. When was the rocket’s velocity greatest? 
• When your teacher tells you to proceed, use your 

handheld to mark the point when the rocket’s 
velocity was greatest.  

• After you have seen the collated class results, choose 
one of the responses, mark it in the and explain why a 
student might have marked that point.  

• Tell whether or not you think this is the correct point. 

Figure 5 

Figure 6 

Figure 7 
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11. When was the rocket’s velocity constant? 
• When your teacher says it is okay to proceed, use 

your handheld to mark a point on the graph where the 
velocity is constant, then view the collated class 
responses.  

• Why would the rocket fall with a constant velocity? 
12. When do you think the rocket touched down?  

• Where did it touch down?  
• Explain why you chose these answers. 

13. When did the rocket’s velocity change from positive to 
negative?  
• When your teacher tells you to do so, mark the point 

on your TI-84 Plus graph that shows when the 
rocket’s velocity changed from positive to negative.  

• After you have seen the collated class results, choose 
one of the responses and explain why a student might 
have marked that point.  

• Tell whether or not you think this is the correct point. 
14. When did the rocket’s velocity change from increasing to 

decreasing? 
• When your teacher tells you to do so, mark the point 

on your TI-84 Plus graph that shows when the 
rocket’s velocity changed from increasing to 
decreasing. 

• The instructor should collate the results and ask 
participants to discuss the reasoning behind various 
answers (screen shots).  

• The responses should remain anonymous so that 
participants (students) are more likely to participate 
in the discussion. 

15. During what time interval was the rocket accelerating? 

16. During what time period was it decelerating? 
• During either or both of 15 and 16, the instructor may 

do screen captures of student responses from the 
home screen or have the students return to the 
Activity Center and do a Quick Poll. 
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S c i e n c e  L e s s o n :  M e a s u r e m e n t  
Concepts 
• Measurements in Inches and 

Centimeters 

Materials 
• TI-84 Plus 
• TI-Navigator system™ 
• LearningCheck files Measure and 

PostMeasure 
• Four objects to measure and ruler 

with inches and centimeters 

Overview 
Participants will collect data and use the Activity Center to determine the 
relationship between inches and centimeters.  

 

Quick Check 

1. Open the TI-Navigator software. 

2. Begin the TI-Navigator class. 

3. Have students log into the TI-Navigator class using the 
NavNet application. 

4. Click on the Tools tab. 

5. Click on Quick Poll. 

6. In the Quick Poll window click on the pull down box and 
select Agree Disagree 3. 

7. Click on Start Poll. 

8. Ask the students the question, “Do you feel comfortable 
with the metric system?” 

9. Stop the Quick Poll. 

10. View the bar graph and discuss the Agree, Neutral, 
Disagree. 

11. Close the Quick Poll window. 

Pre-Assessment For Measurement 

1. Open the LearningCheck software. 

2. Open the LearningCheck file Measure. 

3. Send the assignment Measure to the class by clicking the 
Send to Class icon. 

4. When the Transfer is complete on the student calculators, 
press q (soft key BACK) to go back to the TI-
Navigator home screen. 
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5. Press 2: NETWORK APPS. 

6. Press Í when LearnChk appears. 

7. Highlight Measure and press Í. 

8. Have the students complete the Measure assignment. 

9. When the students are finished, select MENU. 

10. Press 6 to TURN IN the LearnCheck assignment. 

11. When Send is done press BACK. 

12. Press MENU. 

13. Press 5 to EXIT APP. 

14. On the teacher computer, close the LearningCheck 
software. 

15. Open the Class Analysis software. 

16. Click the Choose An Assignment for Analysis icon and 
associate the Measure file. 

17. Click the Add Student Answer Files icon, find the 
students files that were collected, username_umeasure. 
Highlight them and click on Open. 

18. The teacher can view the spreadsheet to privately see the 
pre-knowledge of the class before continuing with the 
lesson. 

Activity 

Computer (Teacher) 

1. Open the Activity Center. 

2. Click on the List tab. 

3. Click on the Contribute pull-down menu and change it to 
Lists. 

4. Click on the Configure button. 

5. In the Create New Lists: 
• Use two lists with list properties “Group Lists as a 

Data Set” 
• Replace L1 with IN and L2 with CM. 
• Click OK. 

6. In the Configure Calculators for Activity: 
• In the Students start with window click on Empty 

Lists. See Figure 1. 
• Click OK. 

7. Click the Start Activity button. 

Figure 1 
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Calculator (Student) 

1. From the TI-Navigator Home Screen on the calculator, 
press 1 to start the ACTIVITY CENTER. 

2. Have students measure four objects in inches and 
centimeters. 

3. The students should record the inches, typing the inches 
in the IN column and the corresponding centimeters in 
the CM column. 

4. When all measurements have been completed, press the 
SEND soft key to SEND the data points to the shared 
workspace in the Activity Center. 

Computer (Teacher) 

1. After all the students have submitted their points, click 
the Stop Activity button. 

2. Click on the Contribute pull-down and change it to 
equations. 

3. Click on the List-Graph tab. 
• Click on Configure Plots (See Figure 2) 
• Click on the Plot1 X-List pull-down and select IN. 
• Click on the Plot1 Y-List pull-down and select CM. 
• Click OK. 

4. Click on the View button and select Zoom Stat. 

5. Click on Configure. (See Figure 3) 
• Set the number of equations to 1. 
• Check Let students view graphs of equations. 
• Check Let students resubmit equations. 
• Check Send current Graph Contents As Background. 
• Click on Empty Equations. 
• Click OK. 
• Click on Start Activity 

Calculator (Student) 

1. Press PLOT. 

2. View the graph. 

3. Press EQN. 

4. Type in an equation to fit the plot (start with 2x). 

5. Press p to see if the equation fits the data. 

6. Repeat steps 3 to 5 until the equation fits the data. 

Figure 2 

Figure 3 
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  7. Press o to SEND the equation to the instructor. 

8. Students may resubmit a new equation by changing the 
equation and pressing SEND again. 

Computer (Teacher) 

1. When students have submitted all of their graphs, the 
teacher can mouse over the graphs and the equation will 
appear generating class discussion. If the Show Students 
box is checked the mouse over will show the students’ 
name also. 

Teacher Notes 

1. The slope of the line 2.54 cm/in is the conversion factor 
for converting between centimeters and inches. The 
equation y=2.54x can also be written as 
centimeters=2.54*inches (cm=2.54*in) 

2. Example: 
• Given 5.00 inches how many centimeters are there? 

y=2.54cm/in*5.00in  y=12.7cm 
• Given 25.0 centimeters how many inches are there? 

25.0cm=2.54cm/in*x  x=9.84in 
3. Conversion Factors: 

• Length: 1 in = 2.54 cm  1 mi = 1.6093 km 
• Mass: 1 oz = 28.35 g  1 lb = 0.4536 kg 
• Volume: 1 gal = 4.5461 L 1 fl oz = 29.574 mL 

Post-Assessment For Measurement 

1. Send the class the Postmeasure LearningCheck 
assignment. 

2. Have the students complete the assignment and submit 
when they are done. 

3. Use the Class Analysis software to see if there was 
improvement in the learning. 
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S c i e n c e  L e s s o n :  C 2 F  P r o g r a m  
A n d  D a ta  Tr a n s f e r  

Concepts 
• Temperature conversion from 

Celsius to Fahrenheit 

Materials 
• TI-84 Plus™ 
• TI-Navigator system™ 
• C2F calculator program 

Overview 
Participants will use Activity Center and a Celsius to Fahrenheit conversion 
program to review the relationship between the two units.  

 

Student Directions 

Receiving C2F Program 

1. Plug the calculator into the hub. 

2. Press Œ. 

3. Select NavNet. 

4. Enter username and password. 

5. When you are logged in, C2F will be transferred to your 
calculator. 

6. Press soft key BACK. 

7. Press 4 to EXIT APP. 

Run C2F 

1. Press . 

2. Select C2F. 

3. Follow the screen instructions. 

4. When the data is gathered a graph will appear. 

5. Press y z to quit. 
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Log Back Into NavNet 

1. Press Œ. 

2. Select NavNet. 

3. Press 1 to start the Activity Center. 

4. Press the soft key SEND to send the lists. 

5. Wait. 

Model The Set Of Data 

1. Press p to observe the plot. 

2. Press p to add an equation. 

3. Enter the model that should fit the graph. 

4. Press p to view the fit. If the graph does not fit go 
back to the equation and adjust it until it fits best. 

5. When your equation fits the data press o to SEND the 
equation. 
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Teacher Directions 

Send C2F To Student Calculators 

1. Open TI-Navigator. 

2. Begin Class. 

3. Click on the Tools tab. 

4. Click on Send to class. 

5. Select the file C2F and click Next. 

6. Send to the class. 

7. Check the Force send to students now box. 

8. Click on Finish. 

Pull Data From Student Calculators 

1. Under the Tools tab click on Activity Center. 

2. Click on the List tab. 

3. Select the Contribute pull down and select Lists.  
See Figure 1. 

4. Click OK on the Create new Lists. See Figure 2. 

5. Select the Lists from calculator button. 

6. Click OK. 

7. Click Start Activity. 

When All Students Lists Have Arrived 

1. Click Stop Activity. 

2. Click on the List-Graph tab. 

3. Change the Contribute pull down menu to Equations.  
See Figure 3. 

Figure 1 

Figure 3 

Figure 2 
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  4. Click on Configure Plots. See Figure 4. 

5. Select L1 from the X-List pull down. 

6. Select L2 from the Y-List pull down. 

7. Click OK. 

8. Click Configure. 

9. Configure Calculators for Activity. See Figure 5. 
• Set the number of equations to 1. 
• Check Let students view graph of equations. 
• Check Let students resubmit equations. 
• Check Send graph contents as background. 
• Select No predefined equations. 
• Click OK. 

10. Click Start Activity. 

11. Discuss the class results. 

Figure 4 

Figure 5 
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S c i e n c e  L e s s o n :  G r a v i t y  L a b  
Concepts 
• Collect Ball Bounce data with CBR™ 
• Estimate the acceleration due to 

gravity based on the data 

Materials 
• TI-84 Plus™ 
• TI-Navigator system™ 
• CBR™ 
• PreGravity LearnCheck file 

Overview 
Participants will use a CBR to collect Ball Bounce data and then using Activity 
Center fit the data to a quadratic and use that to estimate the acceleration due 
to gravity.  

 

Quick Check 

1. Open the TI-Navigator software. 

2. Begin the TI-Navigator class. 

3. Have the students log into the TI-Navigator classroom 
using the NavNet application. 

4. Send the LearnCheck file PreGravity to class. Be sure to 
check Force send to student on the transfer screen. 
See Figure 1. 

5. Have the students answer the LearnCheck assignment on 
their calculator. 

6. Retrieve the results through the Class Analysis software. 
Choose to delete the answers and assignment from the 
student’s calculator. 

7. After all the results have been collected, use the slide 
show option to share and evaluate results. 

8. After a short discussion of the results go to Quick Poll 
and ask the question “Does gravity always operate 
everywhere?” as an Agree Disagree 5. 

9. The Quick Poll results will generate a class discussion. 

10. Stop the poll and end the Navigator class. 

11. Connect a CBR to the instructor’s calculator which is 
connected to an overhead panel or to a TI-Presenter. 

Figure 1 
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Activity 

1. Using the CBL/CBR App on your calculator, select 
RANGER. See Figure 2. 

2. Next select APPLICATIONS from the Main Menu. 
See Figure 3. 

3. Select METERS and BALL BOUNCE. See Figure 4. 

4. As the instructor, follow the screen instructions and 
collect Ball Bounce data. 

5. Connect the instructor’s calculator to the USB link cord. 

6. Begin the TI-Navigator class again and only log in the 
calculator with the Ball Bounce data on it. 

7. Open the Activity Center. 

8. On the Contribute selection, choose List and then 
Configure. 

9. Use two lists, L1 and L2 (the default), as Group Lists as a 
Data Set and then press OK. 

10. Select List from calculator under Students start with, then 
press OK. See Figure 5. 

11. Click the Start Activity button. 

12. Select SEND on the soft key on the calculator with the 
Ball Bounce data. 

13. After Ball Bounce data is transferred, click the Stop 
Activity button. 

14. While the students are logging into the TI-Navigator 
class, change the Activity Center configuration so the 
Students start with Existing activity lists and then click 
OK. 

15. After all the students have logged into the TI-Navigator 
class and entered the Activity Center, click the Start 
Activity button. The students will receive the Ball 
Bounce data on their calculators in L1 and L2. 

Figure 2 

Figure 3 

Figure 4 

Figure 5 
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16. Select the List-Graph tab in the Activity Center and 
Configure Plots to L1 and L2 and then click OK. 
See Figure 6. 

17. Click the Stop Activity button. 

18. Reconfigure to contribute Equations and allow the 
students to supply two equations, view graphs, resubmit 
equation and send graph content as background. Select 
empty equations option for the student. 

19. Click OK and click the Start Activity button. 

20. Assign different groups different bounces and allow them 
to model the parabolic bounce using the vertex form, 
y=a(x-h)2+k, where h and k are the vertex coordinates of 
the individual bounces. 

21. Have students submit and resubmit their equations until 
satisfied with their fits. 

22. Select the Graph-Equation tab and as a class examine the 
results and explore similarities and differences of the 
equations. 

23. Reminding the students that the distance equation used in 
Physics is D=0.5gt2+vt+d0, have them determine the 
acceleration of gravity from this activity. 

24. Have the students press y z to quit and exit the 
application unless doing the extension. 

Extension 

1. Using the Y2 position of the previous Activity Center 
screen, model the bounce peaks using the equation 
y=a*b*(x-c)+d. The b value will approximate the 
retention height of the ball. Different balls or different 
inflation levels could be used and investigated. 

Figure 6 
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  Post Lab Activity 

Using the relationship D=0.5gt2+v0t+d0, where g is equal to  
-9.8 m/s/s and d0 and v0 are the initial height and velocity of 
the problem, answer the following questions. 

1. If a rock is dropped from 40 m, calculate the time it 
would take to hit the ground. 

2. If an object takes 5.3 seconds to fall from rest position, 
calculate its starting height. 

3. If an object is thrown upward vertically at an initial 
velocity of 5.2 m/s and takes 7 seconds to hit the ground, 
calculate the initial height of the object. 

4. If an object is thrown down at -3.2 m/s from a height of 
45 m, calculate the time for the object to reach the 
ground. 

5. If a rock is thrown vertically upward at an initial velocity 
of 5.7 m/s, how long will it take for the rock to reach  
10 m for the first time? The second time? 
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A l g e b r a  L e a r n i n g C h e c k ™  
R e f e r e n c e  S h e e t  

Multiple Choice 

1. Standard Choices: 
• Title: Prime 
• Text: Six is a prime number. 
• Answer Choices: True-False 

2. Custom Choices: 
• Title: Properties 
• Text: Which of the following demonstrates the 

reflexive property? 
• Answer Choices: x=x, yx=xy, 1x=x, (ab)c=a(bc) 

3. Choices on Image: 
• Title: Vertex 
• Text: Which of the following represents the vertex of 

a parabola? 
• Image: Parabola.bmp (See Figure 1) 

Fill In The Blank 

1. Pull Down 
• Title: Polynomial 
• Text: A polynomial with an x^2 term as its highest 

power is a quadratic equation. 
• Choices for text field: linear, exponential, power, 

quadratic 
2. Text/Numeric 

• Title: Prime Number 
• Text: Zero and 1 are neither prime nor composite 

numbers. 

Assessment Information 

Title: First Assignment 

1. Multiple Choice: 
• Title: Equation 
• Text: Solve for x: 6x + 2 = 14 
• Answer Choices: -2, 2, 8/3, -8/3 

Figure 1 
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2. Fill in the blank (drop down): 
• Title: Vocabulary 
• Text: In Algebra, a(n) variable is used to represent an 

unknown value. 
• Choices for text field: equation, coefficient, 

exponent, variable 
3. Fill in the blank (multiple blank): 

• Title: Properties 
• Text: The Additive Identity property states: a + 0 = a 

4. Multiple Choice with Image: 
• Title: X-Intercept 
• Text: Which of the following represents the X-

intercept? 
• Image: x-intercept.bmp (See Figure 2) 

5. Sequencing: 
• Title: Order of Operations 
• Text: Put the following in correct order 
• Choices: Exponents, Add/Subtract, Brackets, 

Multiply/Divide 
6. Open Response: 

• Title: Functions 
• Text: In the space below, describe how to determine 

if the graph of a curve is a function. 
7. Multiple Choice with Standard Choices: 

• Title: Quadratics 
• Text: A quadratic equation has real solutions. 
• Choices: Always-Sometimes-Never 

Figure 2 
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C h e m i s t r y  L e a r n i n g C h e c k ™  
R e f e r e n c e  S h e e t  

Multiple Choice 

1. Standard Choices: 
• Title: Electrons 
• Text: There are 5 valence electrons in chlorine. 
• Answer Choices: True-False 

2. Custom Choices: 
• Title: Sig Figs 
• Text: How many significant figures in 0.0230? 
• Answer Choices: 2, 3, 4, 5 

3. Choices on Image: 
• Title: Atom 
• Text: Where is the proton located? 
• Image: atom.bmp (See Figure 1) 

Fill In The Blank 

1. Pull Down 
• Title: Mass 
• Text: The Mass number is the number of protons and 

neutrons. 
• Choices for text field: protons, neutrons, protons 

neutrons and electrons, protons and neutrons 
2. Text/Numeric 

• Title: Atomic Number 
• Text: The atomic number of sodium is 11. 

Assessment Information 

Title: First Assignment 

1. Multiple Choice: 
• Title: Neutron 
• Text: The neutron is 
• Answer Choices: positive, negative, neutral 

2. Fill in the blank (drop down): 
• Title: Atomic Number 
• Text: The atomic number is the number of protons. 
• Choices for text field: electrons, neutrons, protons 

Figure 1 
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3. Fill in the blank (multiple blank): 
• Title: Ions 
• Text: Cations are positively charged ions and anions 

are negatively charged ions. 
4. Multiple Choice with Image: 

• Title: Polar Bonds 
• Text: Which bond has the greatest polarity? 
• Image: Lewis structure.bmp (See Figure 2) 

5. Sequencing: 
• Title: Metric System 
• Text: Put the metric units in order from largest to 

smallest. 
• Choices: km, hm, dam, m, dm, cm, mm 

6. Open Response: 
• Title: Formula Mass 
• Text: The formula mass of CH4 is: 

7. Multiple Choice with Standard Choices: 
• Title: Ions 
• Text: Ions of the same atom have different number of 

protons. 
• Choices: Agree-Disagree 

Figure 2 
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Multiple Choice 

1. Standard Choices: 
• Title: Parallel Lines 
• Text: If two lines do not cross, they are parallel. 
• Answer Choices: True-False 

2. Custom Choices: 
• Title: Angles 
• Text: Two angles whose sum is 90 degrees are: 
• Answer Choices: supplementary, complementary, 

vertical, linear pair 
3. Choices on Image: 

• Title: Vertex 
• Text: Which of the following represents the vertex of 

an angle? 
• Image: Angle.bmp (See Figure 1) 

Fill In The Blank 

1. Pull Down 
• Title: Equations 
• Text: y = 3x + 4 is in slope-intercept form 
• Choices for text field: point-slope, standard,  

slope-intercept 
2. Text/Numeric 

• Title: Quadrilaterals 
• Text: Quadrilaterals have an angle sum of 360 

degrees and two pair of sides that are parallel. 

Assessment Information 

Title: First Assignment 

1. Multiple Choice: 
• Title: Proving Triangles 
• Text: Which of the following is not a way to prove 

triangles congruent? 
• Answer Choices: ASA, SSA, SAS, AAS 

Figure 1 
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2. Fill in the blank (drop down): 
• Title: Vocabulary 
• Text: Two lines that intersect at a right angle are 

perpendicular. 
• Choices for text field: parallel, skew, perpendicular, 

none of these 
3. Fill in the blank (multiple blank): 

• Title: Squares 
• Text: Squares have all sides congruent and all angles 

equal to 90 degrees. 
4. Multiple Choice with Image: 

• Title: Midpoint 
• Text: The midpoint of segment AB is: 
• Image: Midpoint.bmp (See Figure 2) 

5. Sequencing: 
• Title: Number of Sides 
• Text: Put the following in least to greatest order 

based on the number of sides. 
• Choices: Rhombus, Hexagon, Triangle, Pentagon 

6. Open Response: 
• Title: Linear Pair Postulate 
• Text: In the space below, explain the linear pair 

postulate. 
7. Multiple Choice with Standard Choices: 

• Title: Rhombus 
• Text: The diagonals of a rhombus bisect each other. 
• Choices: True-False 

Figure 2 
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Multiple Choice 

1. Standard Choices: 
• Title: Gravity 
• Text: All objects fall with the same acceleration on 

earth. 
• Answer Choices: True-False 

2. Custom Choices: 
• Title: Friction 
• Text: Which objects would probably give the greatest 

frictional force when in wood? 
• Answer Choices: metal, rubber, sand paper, ice 

3. Choices on Image: 
• Title: SHM 
• Text: Identify where the pendulum would have the 

greatest kinetic energy. 
• Image: Pendulum.bmp (See Figure 1) 

Fill In The Blank 

1. Pull Down 
• Title: Free Fall 
• Text: An object starting at rest will fall 5 m in one 

second. 
• Choices for text field: 10 m, 15 m, 32 m, 5 m 

2. Text/Numeric 
• Title: Falling Objects 
• Text: If a rock is thrown downward with a velocity of 

3 m/s, its final velocity after 4.2 seconds is -44 (with 
a tolerance of +/- 1) 

Assessment Information 

Title: Sound 

1. Multiple Choice: 
• Title: Wave Type 
• Text: Sound waves are which type of waves? 
• Answer Choices: Transverse, Longitudinal, 

Electromagnetic 

Figure 1 
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2. Fill in the blank (drop down): 
• Title: Terms 
• Text: A common term for frequency is pitch. 
• Choices for text field: loudness, noise, scale, pitch 

3. Fill in the blank (multiple blank): 
• Title: Interference 
• Text: When sound waves combine to form larger 

than normal amplitudes it is called positive 
interference and when they cancel each other it is 
called negative interference. 

4. Multiple Choice with Image: 
• Title: Wave Form 
• Text: Identify the node on the sine wave. 
• Image: wave.bmp (See Figure 2) 

(Answer is point c, when X = 0) 
5. Sequencing: 

• Title: Musical Instrument 
• Text: If the following instrument played a middle C, 

place them in order from simple to complex sounds 
produced. 

• Choices: tuning fork, piccolo, flute, oboe 
6. Open Response: 

• Title: Acoustics 
• Text: Explain the factors that must be considered 

when designing a perfect sound system for your car. 
7. Multiple Choice with Standard Choices: 

• Title: Ultrasonic 
• Text: Sound waves can be used to see through things 

that can not be seen with your eyes. 
• Choices: True-False 

Figure 2 
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Multiple Choice 

1. Standard Choices: 
• Title: Census 
• Text: The federal census of population is taken every 

five years. 
• Answer Choices: True-False 

2. Custom Choices: 
• Title: President 
• Text: To serve as President of the United States, a 

person must have attained: 
• Answer Choices: 25 years of age, 35 years of age,  

40 years of age, 45 years of age 
3. Choices on Image: 

• Title: Equilibrium Point 
• Text: Which point represents the equilibrium point 

for the quantity demanded and quantity supplied? 
• Image:  Equilibrium.bmp (See Figure 1) 

Fill In The Blank 

1. Pull Down 
• Title: Government 
• Text: The chief executive and the administrative 

offices make up the Executive branch of government. 
• Choices for text field: Legislative, Judicial, Executive 

2. Text/Numeric 
• Title: Original 13 
• Text: Of the original 13 states, the one with the 

largest representation in the first Congress was 
Virginia.  

Assessment Information 

Title: First Assignment 

1. Multiple Choice: 
• Title: Communism 
• Text: Communism was the type of government in: 
• Answer Choices: Canada, Russia, Germany 

Figure 1 
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2. Fill in the blank (drop down): 
• Title: Presidents 
• Text: The first Republican party candidate elected 

president was Lincoln. 
• Choices for text field: Roosevelt, Reagan, Jefferson, 

Lincoln 
3. Fill in the blank (multiple blank): 

• Title: Economic Policies 
• Text: The Federal Reserve sets monetary policy 

while the Federal Government sets fiscal policy. 
4. Multiple Choice with Image: 

• Title: Quantity vs Price Graph 
• Text: Which point represents where quantity 

demanded equals quantity supplied? 
• Image: Equilibrium.bmp (See Figure 2) 

5. Sequencing: 
• Title: Economists 
• Text: Place in chronological order the following 

economists: 
• Choices: Adam Smith, Karl Marx, John Maynard 

Keynes, John Kenneth Galbraith 
6. Open Response: 

• Title: President 
• Text: A President elected in the general election in 

November takes office the following year on what 
date? 

7. Multiple Choice with Standard Choices: 
• Title: Chief Lawmaker 
• Text: The Supreme Court is the chief lawmaking 

body of the state. 
• Choices: True-False 

Figure 2 
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Check for the latest OS Version for a Calculator 

You have two options to verify if you have the latest 
operating system on your graphing calculator. 

1. Go to the following website to identify the latest version 
for your calculator and check the version on your 
calculator. 
http://education.ti.com/us/product/apps/latest.html 

2. Open TI-Connect and connect your calculator to the 
computer using the TI Connectivity cable. Then click the 
blue circle above “Updates”. You need to have an 
internet connection as the software checks the TI site for 
the version of the latest OS. See Figure 1. 

Check OS Version of the TI-84 Calculator 

1. Turn on your graphing calculator. 

2. Press y Ã [MEM]. 

3. Select 1: About. 

4. Check for OS version number under the type of 
calculator. See Figure 2. 

Upgrading the OS using the Computer 

1. Before you begin to install any new Apps or update your 
OS, be sure you have a new set of batteries in your TI 
calculator for optimum performance. 

2. Download the latest version of the OS from 
http://education.ti.com/us/product/apps/latest.html onto 
your computer desktop. 

3. Open TI-Connect and connect your calculator to the 
computer using the TI-Connectivity cable. 

4. Use the mouse to drag the OS file on the desktop to the 
TI Device Explorer icon in the TI-Connect window.  
See Figure 3.  
You will see the file transfer to the calculator. 

Figure 1 

Figure 2 

Figure 3 
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 Upgrading the OS from Another Calculator 

1. Link a calculator with the correct OS to another 
calculator which needs the OS using a unit to unit cable. 

2. On the “Receiving Calculator”: 
• Turn the calculator on if it is not on. 
• Press y „ [LINK]. 
• Use the ~ button to move to the RECEIVE menu. 
• Choose 1:Receive by pressing Í. 
• The calculator is “Waiting” to receive the OS. 

3. On the “Sending Calculator”: 
• Turn the calculator on if it is not on. 
• Press y „ [LINK]. 
• Scroll using the † button to the option G:SendOS 

under the SEND menu. 
• Choose G:SendOS by pressing Í. 
• The calculator will now send the OS to the other 

calculator. 
4. Note: The receiving calculator will give you a warning 

that by upgrading the OS all RAM will be erased and it 
may erase archived files. Select “Continue” if you want 
to continue with the upgrade. 
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Sending Apps 

1. Open TI-Navigator™ software. 

2. Click on Tools tab. See Figure 1. 

3. Click on App Transfer icon. See Figure 2. 

4. You will see the App Transfer Window. See Figure 3. 

5. Click Start Transfer button. You will see the transfer 
window with the status of the transfer. See Figure 4. 

6. When all calculators are done, click the stop transfer 
button. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 
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7. When the Progress screen (see Figure 5) closes, click the 

close button in the transfer window. 

8. Click the close button at the bottom of the transfer 
window. 

Notes 
• To add applications to be sent, click on the Add 

Application button (see Figure 6) and navigator to the 
location of the app. 

• Apps to be sent must be checked in the send column. 
• To remove an app from being sent, uncheck the box 

to the left of the app name by clicking in the box. 
• A class must not be in session for App Transfer to 

work. 

Figure 5 

Figure 6 
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Logging In 

1. Press the Œ button. 

2. Access the NavNet App by using the down arrow † on 
the upper right side of the calculator to move the cursor 
to NavNet. See Figure 1. 

3. Press Í to open the NavNet application. 
See Figure 2. 

4. Students login to NavNet with a username and password 
assigned by the teacher. 
• The minimum number of characters required to log in 

is three. The maximum number of characters is 32. 
5. Now the student is ready to participate in a TI-Navigator 

enhanced classroom. See Figure 3. 

6. Some teachers create “Direction Cards” to aid students in 
learning the procedure of logging into the Navigator 
classroom. See Figure 4. 
• It is also helpful for students to write their name and 

password on it. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 
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Navigation: Overview 

1. LearningCheck uses the directional arrow keys, number 
keys, and soft keys for navigation. The diagram below 
shows the location of these keys. 

Directional 
arrow keys 

Soft Keys 

Number Keys 

Navigation: Soft Keys 

1. The Soft Keys correspond with the five keys located at 
the top of the TI-84 Plus. 

The soft key 
“MENU” matches 
up with the o Key. 

The soft key “NEXT” 
matches up with the 
s Key. 
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Entering Answers: Multiple Choice 

1. Use the directional arrow keys to scroll through answer 
choices and the Í key to select the answer.  

2. If you want to deselect an answer, press Í again.  

3. To move to the next item, press the soft key "NEXT." 

The Directional 
Arrow Keys 
scroll through 
answer choices. 

The Soft Key 
“NEXT” 
matches up 
with the s 
Key. 

The small box notifies 
the student that they 
have answered that 
question. 

The ** notifies the 
student that the item 
contains text or picture 
they must review. 
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Entering Answers: Sequencing 

1. To select a line to move, press the Í key. 

2. To move the line, use the directional up and down keys.  

3. Press Í to deselect the line. 

Entering Answers: Fill-In-The-Blank 
1. To select a blank, press the Í key. 
2. Type or select your answer. 
3. To move to another blank, press the soft key, 

"TAB." 

If you need to type 
text, the Alpha lock 
will be turned on.  
The upper right 
corner shows you 
the Alpha status 

Press ENTER to 
select a line to 
move. When a line 
is selected, it will 
be highlighted. 

Menu Options: Item List 

1. Press the “MENU” soft key to access the main menu for 
LearningCheck.  

2. To view the complete list of items in the assignment, 
press the Â key to select the Item list option. 

Option 3 in the Main 
Menu will list the 
items of the current 
assignment. 
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Menu Options: Special Characters 

1. At times, you may want to put special characters (Greek, 
math symbol, etc) into your answers. 

2. You can do so by going to the main menu and selecting 
Special Characters. 

Use the Directional 
Arrows to highlight the 
character you want. 
Press Í to paste it 
into your answer. 

Menu Option: Pause App 

1. You can pause the App to use some of the functionality 
of the TI-84 Plus. You can do so by going to the menu 
screen and selecting the Pause App option. 

2. To resume the assignment, press the Œ key and select 
NavNet. 

3. Select 2:Network Apps. 

4. Scroll to LearnChk and press Í. 

Option 5 in the Main 
Menu will Pause the 
LearningCheck App. 

Option 8 will allow 
you to attach and 
use the keyboard. 

Menu Option: Use Keyboard 

5. When a student is logged into the NavNet app the I/O 
port is dedicated to the Navigator Network. 

6. To use a TI keyboard to answer a LearningCheck 
question, you must go to the menu screen and select Use 
Keyboard. Then you may plug the calculator to a 
keyboard and answer the questions. 

7. To reconnect the calculator to the Navigator system you 
must go to the menu screen and select Resume Network. 
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Previewing A Question 

1. When creating questions for LearningCheck™, you may 
need to preview the question format using the Preview 
function. 

2. Choose the type of question you would like to create 
from the right side of the LearningCheck software. 
See Figure 1. 

3. Enter the text and/or graphic(s) for your question. 
See Figure 2. 

4. When you are finished entering the question, go to Tools, 
Preview, Preview Selected. 
• Note: You can also create all your questions first, and 

then choose Preview All. See Figure 3. 
Figure 1 

Figure 2 

Figure 3 
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5. It is important to preview your questions to check the 

actual appearance of the question on the calculator 
screen. See Figures 4 and 5. 
• The question in Figure 4 shows answers that have 

been cut off on the right-hand side of the calculator 
screen. 

• The question in Figure 5 shows answers that fit 
correctly in the screen. 

• Although this may be a teacher preference, 
previewing the question can prevent horizontal 
scrolling.  

Figure 4 

Figure 5 
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Sending An Education Document 

1. Open the TI-Navigator™ software. 

2. Begin class and have the students log into the NavNet 
application. 

3. Open the LearningCheck software by clicking the 
LearningCheck icon. See Figure 1. 

4. Click OK on the User Profile Section window. 

5. Open the education document which is to be sent by 
clicking the Open file icon (or choosing Open under the 
File menu). See Figure 2. 

6. Choose the file to be sent. 

7. Click on the Send to Class icon in the LearningCheck 
software. See Figure 3. 

8. Select the appropriate properties and click the Send 
button. See Figure 4. 

9. You will be returned to the TI-Navigator software screen 
and the file will be listed under the Class Record listing. 
See Figure 5. 

10. When sending an education document through 
LearningCheck, it will be sent to the entire class as a 
“force send”. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 

Figure 5 
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Method 1 – Using Class Analysis 

1. Open the TI-Navigator software. 

2. Begin Class and have the students log into the NavNet 
application. 

3. Open the Class Analysis software by clicking on the 
Class Analysis icon. See Figure 1. 

4. Click the “Choose an Assignment for Analysis” icon to 
associate the education document which is to be 
collected. See Figure 2. 

5. Browse for the education document for which you wish 
to collect the answers. 

6. Click Open. 

7. You should see the document listed after “Assignment 
Title”. See Figure 3. 

8. Click on the Collect Answer Files from Classroom 
Devices icon. See Figure 4. 

9. Select the appropriate properties and click the Start 
Transfer button. See Figure 5. 

10. You will be returned to the TI-Navigator software screen 
and you will receive the following message. See Figure 6. 
Click OK. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 

Figure 5 

Figure 6 
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11. The answer file will be listed under the Class Record 
listing (UASSIGNM) with the blue collect arrow in front 
of it. See Figure 7. 

12. If you choose to delete the assignment file and/or answer 
file, the red x symbol will be in front of them in the Class 
Record listing. See Figure 8. 

13. Once you have received all the answer files that you 
expect to receive, click the Stop button located above the 
Class Record listing under External Request. This is what 
the warning was earlier. See Figure 9. 
• Remember, if you click on a file in the Class Record 

listing, you can see who had completed the request 
(green box around the student) and who has not 
completed the request (red box around the student). 

14.  Returning to the Class Analysis software, the assignment 
has been graded and populated into a spreadsheet. 

15. The slide show of anonymous class results can be viewed 
by clicking the Class Results Slide Show icon. 
See Figure 10. 

16. Adjustments can be made to the spreadsheet and saved 
for future analysis. 

17. When collecting an education document through Class 
Analysis, it will be collected from the entire class as a 
“force collect”. 

Method 2 – Not Using Class Analysis 

1. Open the TI-Navigator software. 

2. Begin Class and have the students log into the NavNet 
application. 

3. Click on the “Collect from Class” icon. See Figure 11. 

4. Select the education document for which you want to 
collect the answer file(s) and click Next. 
• If you would like to collect more than one file from 

the student calculators, then highlight all desired files 
by using the CTRL key. 

• If you want to collect a file you recently sent the 
class, choose “Recent Files” and the files will be 
listed which have been recently sent. See Figure 12. 

Figure 7 

Figure 8 

Figure 9 

Figure 10 

Figure 11 

Figure 12 
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5. Select Class Send or Individual Student(s) using the 
CTRL key to select nonconsecutive students. 
See Figure 13. 

6. If force collect is desired, click in the white box to the left 
of “Force collect from students now”. See Figure 14. 

7. If delete after collecting is checked, collection will delete 
both assignment and answer file from the calculators. 

8. Click on Next. 

9. Choose location where you would like the collected 
answer file(s) to be saved. This is very important to 
remember for when you look at the files. See Figure 15. 

10. Click Finish. 

11. You will see the collected answer file listed in the Class 
Record List on the Navigator Home screen. This line will 
also show how many of the student answer files have 
been collected. Remember, answer files begin with the 
letter “U” followed by the first seven letters of the 
assignment file. See Figure 16. 

12. To view the answer files, they need to be opened in Class 
Analysis. 

13. Open the Class Analysis software by clicking the Class 
Analysis icon. See Figure 17. 

14. Click the “Choose an Assignment for Analysis” icon to 
associate the education document which is to be 
collected. See Figure 18. 

15. Browse for the education document for which you wish 
to collect the answers. 

16. Click Open. 

Figure 13 

Figure 14 

Figure 15 

Figure 16 

Figure 17 

Figure 18 
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  17. You should see the document listed after Assignment 
Title. See Figure 19. 

18. Since the files have already been collected, we need to 
open those particular student answer files. 

19. Click on the Add Student Answer Files icon. 
See Figure 20. 

20. Browse for the answer files. The names will have the 
following format: LastName_FirstName_UASSIGNM. 
(e.g. Smith_Jon_UTEST). 

21. Click Open and the files are loaded into the spreadsheet. 

22. The slide show of anonymous class results can be viewed 
by clicking the Class Results slide Show icon. 
See Figure 21. 

23. Adjustments can be made to the spreadsheet and save for 
future analysis. 

Verifying Transfer of Files from Students 

1. From the Navigator Home Screen, select the file to be 
verified in the Class Record. 

2. The seating chart view of the class will indicate if a 
student has successfully transferred the file, not attempted 
to transfer the file, or there was a problem with the 
transfer of the file by a colored box around the student 
icon. See Figure 22. 

3. If the file was transferred successfully, then the box will 
be green. 

4. If the file has not been transferred, then the box will be 
red. 
• If the transfer was a “Force collect”, this may be 

because the student is not logged into the Navigator 
class. 

• If the transfer was not a “Force collect”, then the 
student hasn’t initiated the transfer yet. 

5. If there was a problem with the transfer of the file, then 
the box will be yellow. 
• If the transfer was a “Force collect”, this indicates 

that the student did not have the requested file on 
their calculator. 

Figure 19 

Figure 20 

Figure 21 

Figure 22 
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Setting Up The Class Record to Send All Types 
of Calculator Files 

1. Open the TI-Navigator™ software. 

2. Begin Class and have the students log into the NavNet 
application. 

3. Click on the “Send to Class” icon. See Figure 1. 

4. Select all the files you wish to send to the class. Use the 
CTRL key to select nonconsecutive files. Click Next. 
See Figure 2. 

5. Select Class Send or Individual Student(s) Send. 
• If you would like to send to a subset of students only, 

then highlight all desired students by using the CTRL 
key. See Figure 3. 

• An alternative would be to select the students before 
clicking on the “Send to Class” icon from the Seating 
Chart view of the class on the Navigator Home 
screen. 

6. If force send is desired, click in the white box to the left 
of “Force send to students now”. See Figure 4. 

7. Click on Finish. 

8. You will see the sent file(s) listed in the Class Record 
List on the Navigator Home screen. This line will also 
show how many of the students have received the files. 
See Figure 5. 

Student Retrieval of Files in Class Record 

1. If the file(s) were sent as a “force send”, then the students 
will receive the files automatically. 
• All students who have already logged into the TI-

Navigator classroom will automatically receive the 
files even if they are not currently in the NavNet 
App. 

• If the student hasn’t logged into the TI-Navigator 
classroom yet, then they will receive the files as soon 
as they log into the NavNet App. 

2. If the file(s) were not forced to the students, then the 
students must retrieve them. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 

Figure 5 
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3. From the TI-Navigator Home screen on the student 

calculator, select 3:Transfers. 

4. Select 1:Auto Send/Recv. 

5. The student will receive all file(s) designated for them in 
the Class Record. 

6. If there are no files to receive, then the student receives 
the message “No Files To Transfer”. 

Verifying Transfer of Files to Students 

1. From the TI-Navigator Home screen, select the file to be 
verified in the Class Record. 

2. The seating chart view of the class will indicate if a 
student has successfully received the file or has not 
received the file by a colored box around the student 
icon. See Figure 6. 

3. If the file was successfully received by the student, then 
the box will be green. 

4. If the file was not received by the student, then the box 
will be red. 
• If the transfer was a “force send”, this may be 

because the student is not logged into the TI-
Navigator class. 

• If the transfer was not a “force send”, then the student 
has not initiated the transfer yet.  

Figure 6 
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Collecting Files 

1. Open the TI-Navigator software. 

2. Begin Class and have the students log into the NavNet 
application. 

3. Click on the “collect from class” icon. See Figure 1. 

4. Select the file(s) to be collected and click Next. 
See Figure 2. 
• If you would like to collect more than one file from 

the student calculators, then highlight all desired files 
by using the “Ctrl” key. 

• If you want to collect a file you recently sent the 
class, choose “Recent Files” and the files will be 
listed which have been recently sent. 

5. Select Class or Individual Student(s) using the “Ctrl” key 
to select non-consecutive students. 

6. If “Force collect” is desired, click in the white box to the 
left of “Force collect from students now”. See Figure 3. 

7. If “Delete after collecting” is checked, after the collection 
both the assignment and answer file will be deleted from 
the calculators. See Figure 4 

8. Click on Next. 

9. Choose location where you would like the collected 
file(s) to be saved. See Figure 5. 

10. Click Finish. 

11. You will see the collected file listed in the Class Record 
List on the Navigator Home Screen. This line will also 
show how many of the students’ files have been received. 
See Figure 6. 

Student Transfer of Files in Class Record 

1. If the file(s) were collected as a “Force collect”, then the 
students will transfer the file(s) automatically. 
• All students who have already logged into the 

Navigator classroom will automatically transfer the 
files even if they are not currently in the NavNet 
App. 

Figure 1 

Figure 2 

Figure 3 

Figure 4 

Figure 6 

Figure 5 
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• If the student hasn’t logged into the Navigator 

classroom yet, then they will transfer the files as soon 
as they log into the NavNet App. 

2. If the files were not forced from the students, then the 
students must transfer them. 

3. From the TI-Navigator (NavNet) Home Screen on the 
calculator, select 3:Transfers. 

4. Select 1:Auto Send/Recv. 

5. The students will transfer all file(s) designated for them 
in the Class Record. 

Verifying Transfer of Files from Students 

1. From the Navigator Home Screen, select the file to be 
verified in the Class Record. 

2. The seating chart view of the class will indicate if a 
student has successfully transferred the file, not attempted 
to transfer the file, or there was a problem with the 
transfer of the file by a colored box around the student 
icon. See Figure 7. 

3. If the file was transferred successfully, then the box will 
be green. 

4. If the file has not been transferred, then the box will be 
red. 
• If the transfer was a “Force collect”, this may be 

because the student is not logged into the Navigator 
class. 

• If the transfer was not a “Force collect”, then the 
student hasn’t initiated the transfer yet. 

5. If there was a problem with the transfer of the file, then 
the box will be yellow. 
• If the transfer was a “Force collect”, this indicates 

that the student did not have the requested file on 
their calculator. 

Figure 7 
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Aggregating 
There are two types of aggregating data: aggregating of data 
sets and aggregating of lists. The aggregating of data sets has 
the assumption that the collected lists of data from the 
students are considered pairs whose dimensions must match. 
The aggregating of lists has the assumption that the lists are 
independent and may have different dimensions. In either 
case, the aggregated data may be returned to the students for 
further investigation on their calculators. 

Aggregating of Data Sets 

1. Open the TI-Navigator™ software. 

2. Begin Class and have the students log into the NavNet 
application. 

3. Open the Activity Center in the Navigator software. 

4. Select the List tab. 

5. From the Contribute pull-down menu within the Activity 
Center select Lists. See Figure 1. 

6. Select “Create New List”. See Figure 2. 

7. Select “Group Lists as a Data Set” and choose the 
number of lists you wish to collect from the students (e.g. 
(x, y, z) pairs requires 3 lists). If desired, change the 
names of the lists. 

8. Click OK. 

9. Select the Configure button. 

10. Choose the settings you wish for the activity along with 
the setting “Students start with: Empty lists”. 

11. Click OK. 

12. Click the “Start Activity” button. 

13. Once the students enter the Activity Center on their 
calculators, they are able to enter their data sets into the 
given lists and send them. 

Figure 1 

Figure 2 
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14. If the student enters data which do not have the same 
dimensions, they will get an error message “Lists Must 
Be The Same Length” when they try to send. 

15. All the students’ data will appear on the Navigator’s 
Activity Center. 

16. If desired, the data can be plotted on the screen from the 
List-Graph tab and clicking the “Configure Plots” to set 
up the plot. 

17. Click the “Stop Activity” button. 

Aggregating of Lists 

1. Open the TI-Navigator software. 

2. Begin Class and have the students log into the NavNet 
application. 

3. Open the Activity Center in the TI-Navigator software. 

4. Select the List tab. 

5. From the Contribute pull-down menu within the Activity 
Center select Lists. See Figure 3. 

6. Select “Create New List”. See Figure 4. 

7. Select “Create independent lists” and choose the number 
of lists you wish to collect from the students. 

8. Click OK. 

9. Select the Configure button. 

10. Choose the settings you wish for the activity. 

11. Click OK. 

12. Click the “Start Activity” button. 

13. Once the students enter the Activity Center on their 
calculators, they are able to enter their data into the given 
lists and send them. 

14. All the students’ data will appear on the TI-Navigator’s 
Activity Center. 

15. If desired, the data can be plotted on the screen from the 
List-Graph tab and clicking the “Configure Plots” to set 
up the plot. 

16. Click the “Stop Activity” button. 

Figure 3 

Figure 4 
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Returning Aggregated Data to the Student 
Calculators 

1. After receiving data from the students, it is desirable to 
return the aggregated lists to the student calculators. 

2. In the Activity Center, click the “Configure” button. 

3. Choose the “Students start with: Existing activity lists”. 
See Figure 5. 

4. Click OK. 

5. Click the “Starting Activity” button. 

6. The students who are in the Activity Center on their 
calculators will receive the aggregated lists on their 
calculators. 

7. When all the students have received the lists, click the 
“Stop Activity” button. 

8. Students may now exit the NavNet application and 
investigate the aggregated data using their calculator. 

Figure 5 
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